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Operational Precautions and
Limitations 1

Note: Before operating the system, carefully read all of the sections of this guide.

This section contains general safety-related information and provides regulatory compliance information. It also
describes potential hazards and associated warnings for the system and the precautions that should be taken to
minimize the hazards.

In addition to this section, refer to Glossary of Symbols on page 125 for information about the symbols and
conventions used in the laboratory environment, on the system, and in this documentation. Refer to the Site
Planning Guide for site requirements, including AC mains supply, source exhaust, ventilation, compressed air,
nitrogen, and roughing pump requirements.

General Safety Information

To prevent personal injury or system damage, read, understand, and obey all of the safety precautions and warnings
in this document, the manufacturer chemical safety data sheet (SDS), and product label information. These labels
are shown with internationally recognized symbols. Failure to heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state, provincial, and local environmental health and
safety (EHS) regulations. The information provided covers system-related safety information applicable to the
operation of the system. It does not cover every safety procedure that should be practised. Ultimately, the user
and the organization are responsible for compliance with federal, state, provincial, and local EHS regulations and
for maintaining a safe laboratory environment.

Refer to the appropriate laboratory reference material and standard operating procedures.

Regulatory Compliance

This system complies with the regulations and standards listed in this section. Refer to the Declaration of Conformity
included with the system and the individual system components for dated references. Applicable labels have been
affixed to the system.

Australia and New Zealand
¢ Electromagnetic Compatibility (EMC): Radio Communications Act 1992 as implemented in these
standards:

¢ Electromagnetic Interference—AS/NZS CISPR 11/ EN 55011/ CISPR 11 (Class A). Refer to Electromagnetic
Interference on page 13.

System User Guide TripleTOF® 5600/5600+ System
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Operational Precautions and Limitations

Safety: AS/NZ 61010-1 and IEC 61010-2-061

Canada

Electromagnetic Interference (EMI): CAN/CSA CISPR11. This ISM device complies with Canadian
ICES-001. Refer to Electromagnetic Interference on page 13.

Safety:
e (CAN/CSA C22.2 No. 61010-1
e (CAN/CSA C22.2 No 61010-2-061

Europe

Electromagnetic Compatibility (EMC): Electromagnetic Compatibility directive 2014/30/EU as
implemented in these standards:

e EN61326-1

e EN55011 (Class A)
Refer to Electromagnetic Compatibility on page 13.

Safety: Low Voltage Directives 2014/35/EU as implemented in these standards:
e EN61010-1
e EN61010-2-061

Waste Electrical and Electronic Equipment (WEEE): Waste Electrical and Electronic Equipment 2012/
96/EEC, as implemented in EN 40519. Refer to Waste Electrical and Electronic Equipment on page 14.

Packaging and Packaging Waste (PPW): Packaging and Packaging Waste Directive 94/62/EC
RoHS Restriction of Hazardous Substances: RoHS Directive 2011/65/EU

United States

Radio Emissions Interference Regulations: 47 CFR 15, as implemented in FCC Part 15 (Class A)
Safety: Occupational Safety and Health Regulations, 29 CFR 1910, as implemented in these standards:
e UL61010-1

e |[EC61010-2-061

TripleTOF® 5600/5600+ System System User Guide
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Operational Precautions and Limitations

International

¢ Electromagnetic Compatibility (EMC):
e |EC61326-1
e |ECCISPR 11 (Class A)
e |EC61000-3-2

e [EC61000-3-3
Refer to Electromagnetic Compatibility on page 13.

e Safety:

e [EC61010-1
e [EC61010-2-061

Electrical Precautions

VAV

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the
covers might cause injury or malfunctioning of the system. The covers need
not be removed for routine maintenance, inspection, or adjustment. Contact
a SCIEX Field Service Employee (FSE) for repairs that require the covers to be
removed.

¢ Follow required electrical safe work practices.

e Use cable management practices to control electrical cables. This will reduce the chance of a tripping hazard.

For information about system electrical specifications, refer to the Site Planning Guide.

AC Mains Supply

Connect the system to a compatible AC mains supply as instructed in this guide.

VAV
VAV

WARNING! Electrical Shock Hazard. Use only qualified personnel for the
installation of all of the electrical supplies and fixtures, and make sure that
all of the installations adhere to local regulations and safety standards.

WARNING! Electrical Shock Hazard. Make sure that the system can be
disconnected from the mains supply outlet in an emergency. Do not block
the mains supply outlet.

System User Guide TripleTOF® 5600/5600+ System
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Operational Precautions and Limitations

WARNING! Electrical Shock Hazard. Use only the power cables supplied with
the system. Do not use power cables that are not properly rated for the
operation of this system.

An external line transformer is not needed for the mass spectrometer or roughing pump.

Protective Earth Conductor

The mains supply must include a correctly installed protective earth conductor. The protective earth conductor
must be installed or checked by a qualified electrician before the system is connected.

WARNING! Electrical Shock Hazard. Do not intentionally interrupt the
protective earth conductor. Any interruption of the protective earth conductor
creates an electrical shock hazard.

e e WARNING! Electrical Shock Hazard. Make sure that a protective earth
conductor (grounding cable) is connected between the sample loop and an
appropriate grounding point at the ion source. This supplementary grounding
will reinforce the safety configuration specified by SCIEX.

Chemical Precautions

A A WARNING! lonizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
fa Determine whether decontamination is required prior to cleaning or
maintenance. The customer must decontaminate the system prior to cleaning
@ or maintenance if radioactive materials, biological agents, or toxic chemicals
have been used with the system.

E: WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.

‘ WARNING! Biohazard, Toxic Chemical Hazard. Connect the drain tubing to
g the mass spectrometer and the source exhaust drain bottle properly, to
prevent leaks.

TripleTOF® 5600/5600+ System System User Guide
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Operational Precautions and Limitations

¢ Determine which chemicals have been used in the system prior to service and regular maintenance. Refer to
the Safety Data Sheets for the health and safety precautions that must be followed with chemicals. SCIEX
Safety Data Sheets can be found at sciex.com/tech-regulatory.

o Work in a well-ventilated area or fume hood.

e Always wear assigned personal protective equipment, including powder-free neoprene or nitrile gloves, safety
glasses, and a laboratory coat.

¢ Avoid ignition sources when working with flammable materials, such as isopropanol, methanol, and other
flammable solvents.

¢ Take care in the use and disposal of any chemicals. Potential risk of personal injury if proper procedures for
handling and disposing of chemicals are not followed.

e Avoid skin contact with chemicals during cleaning and wash hands after use.
e Make sure that all exhaust hoses are connected properly and that all connections are functioning as designed.
e Collect all spent liquids and dispose of them as hazardous waste.

e Comply with all of the local regulations for the storage, handling, and disposal of biohazardous, toxic, or
radioactive materials.

¢ (Recommended) Use secondary containment trays beneath the roughing pump, the solvent bottles, and the
waste collection container to capture potential chemical spills.

Ventilation Precautions

The venting of fumes and disposal of waste must comply with all of the federal, state, provincial, and local health
and safety regulations. It is the responsibility of the customer to make sure that the air quality is maintained in
compliance with local health and safety regulations.

The source exhaust system and roughing pump must be vented to a dedicated laboratory fume hood or an external
exhaust system.

A WARNING! Fire Hazard. Make sure that the source exhaust system is connected and
functioning to prevent flammable vapor from accumulating in the ion source.

A A WARNING! lonizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
£a Take care to vent exhaust gases to a dedicated laboratory fume hood or
exhaust system and make sure that the ventilation tubing is secured with
@ clamps. Make sure that the laboratory has appropriate air exchange for the
work performed.

System User Guide TripleTOF® 5600/5600+ System
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Operational Precautions and Limitations

f} . WARNING! lonizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Do not operate the mass spectrometer if the source exhaust drain and

roughing pump exhaust hoses are not properly connected to the laboratory

@ ventilation system. Perform a regular check of the exhaust tubing to make

sure that there are no leaks. The use of mass spectrometers without proper

system ventilation might constitute a health hazard and might result in serious

injury.

A WARNING! lonizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.

Use the ion source only if you have knowledge of and training in the proper
use, containment, and evacuation of toxic or injurious materials used with
the ion source.

Chemical Hazard. Discontinue use of the ion source if the ion source window
is cracked or broken and then contact a SCIEX Field Service Employee (FSE).

& Any toxic or injurious materials introduced into the equipment will be present
in the source exhaust output. Dispose of sharps following established
laboratory safety procedures.

é@ i} WARNING! Puncture Hazard, lonizing Radiation Hazard, Biohazard, or Toxic

Environmental Precautions

Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing supplies and
fixtures. Make sure that all of the installations comply with local bylaws and biohazard regulations. For information
about the required environmental conditions for the system, refer to the Site Planning Guide.

Allow access space around the equipment when setting up the system.

E DANGER! Explosion Hazard. Do not operate the system in an environment containing
explosive gases. The system is not designed for operation in an explosive

environment.

WARNING! Biohazard. For biohazardous material use, always comply with local
A@ regulations for hazard assessment, control, and handling. This system or any part
is not intended to act as a biological containment.

TripleTOF® 5600/5600+ System System User Guide
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Operational Precautions and Limitations

CAUTION: Potential Mass Shift. Maintain a stable ambient temperature. If the temperature
changes by more than 2 °C per hour, then the resolution and mass calibration might be
affected.

Electromagnetic Environment

Electromagnetic Compatibility

Basic Electromagnetic Environment: Environment existing at locations characterized by being supplied
directly at low voltage from the public mains network.

Performance Criteria A (Criteria A): Equipment shall operate as intended with no degradation of performance
and no loss of function during or after test.

Performance Criteria B (Criteria B): Equipment may experience loss of function (one or more) during test
but shall operate as intended with some degradation of performance and functions self-recoverable after test.

Performance Criteria C (Criteria C): Equipment may experience loss of function (one or more) during test
but shall operate as intended with some degradation of performance and functions recoverable by operator after
test.

The equipment is intended for use in a basic electromagnetic environment.

The expected performance loss under the electromagnetic immunity conditions is less than 20% change in total
ion count (TIC).

Make sure that a compatible electromagnetic environment for the equipment can be maintained so that the device
will perform as intended. If the power supply line is subject to high electrical noise, then install a surge protector.

Electromagnetic Interference

Class A Equipment: Equipment which is suitable for use in all establishments other than domestic and those
directly connected to a low voltage power supply network which supplies buildings used for domestic purposes.
[Derived from CISPR 11:2009, 5.3] Class A equipment shall meet Class A limits.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part
15 of the FCC (Federal Communications Commission) Compliance Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is

operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the operator's manual, can cause harmful interference to radio
communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case you will be
required to correct the interference, at your own expense. Changes or modifications not expressly approved by
the manufacturer could void your authority to operate the equipment.
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Decommissioning and Disposal

E/ WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.

Before decommissioning, decontaminate the entire system following local regulations.

When removing the system from service, separate and recycle different materials according to national and local
environmental regulations. Refer to Storage and Handling on page 106.

Note: SCIEX will not accept any system returns without a completed Decontamination Form. Contact an FSE
to obtain a copy of the form.

Do not dispose of system components or subassemblies, including computer parts, as unsorted municipal waste.

Waste Electrical and Electronic Equipment

Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of
waste, electrical, and electronic equipment (WEEE). To safely dispose of this equipment, contact a local Customer
Service office for complimentary equipment pick-up and recycling.

Qualified Personnel

Only qualified SCIEX personnel shall install, inspect, and service the equipment. After installing the system, the
Field Service Employee (FSE) uses the Customer Familiarization Checklist to orient the customer on system
operation, cleaning, and basic maintenance.

Only personnel qualified by the manufacturer shall maintain the equipment. A laboratory designate can be
familiarized with the Qualified Maintenance Person (QMP) procedures during the installation. A QMP is a person
who is suitably aware of the electrical and chemical risks associated with servicing laboratory equipment.

Laboratory Conditions

Operating Conditions

The system is designed to operate safely under these conditions:
¢ Indoors

e Altitude: Up to 2 000 m (6 400 feet) above sea level

e Ambient temperature: 5 °C (41 °F) to 40 °C (104 °F)

TripleTOF® 5600/5600+ System System User Guide
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Operational Precautions and Limitations

¢ Relative humidity: 80% for temperatures up to 31 °C (88 °F), decreasing lineraly to 50% at 40 °C (104 °F)
* Mains supply voltage fluctuations: +10% of the nominal voltage

¢ Transient overvoltages: Up to the levels of Overvoltage Category Il

e Temporary overvoltages on the mains supply

e Pollution degree: Pollution Degree 2

Performance Specifications

The system is designed to meet specifications under these conditions:

e An ambient temperature of 18 °C to 25 °C (64 °F to 77 °F)
Over time, the temperature must remain within a range of 2 °C (3.6 °F) from the temperature at the time of
last calibration, with the rate of the change in temperature not exceeding 2°C (3.6°F) per hour. Ambient
temperature fluctuations exceeding the limits might result in mass shifts in spectra.

e Relative humidity from 20% to 80%, non-condensing

Equipment Use and Modification

WARNING! Personal Injury Hazard. Contact the SCIEX representative if product
installation, adjustment, or relocation is required.

e e WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the
covers might cause injury or malfunctioning of the system. The covers need
not be removed for routine maintenance, inspection, or adjustment. Contact
a SCIEX Field Service Employee (FSE) for repairs that require the covers to be
removed.

WARNING! Personal Injury Hazard. Use SCIEX-recommended parts only. Use of parts
not recommended by SCIEX or use of parts for any purpose other than their intended
purpose can put the user at risk of harm or negatively impact system performance.

Use the mass spectrometer and ion source indoors in a laboratory that complies with the environmental conditions
recommended in the Site Planning Guide.

If the mass spectrometer and ion source are used in an environment or in a manner not prescribed by the
manufacturer, then the protection provided by the equipment might be impaired.

Unauthorized modification or operation of the mass spectrometer and ion source might cause personal injury and
equipment damage, and might void the warranty. Erroneous data might be generated if the mass spectrometer
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and ion source is operated either above or below the recommended environmental conditions or operated with
unauthorized modifications. Contact an FSE for information on servicing the system.

Contact Us
SCIEX Support

e sciex.com/contact-us

® sciex.com/request-support

Customer Training

e In North America: NA.CustomerTraining@sciex.com
¢ In Europe: Europe.CustomerTraining@sciex.com

e Qutside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center

e SCIEXUniversity

CyberSecurity

For the latest guidance on cybersecurity for SCIEX products, visit
sciex.com/Documents/brochures/win7-SecurityGuidance.pdf.

Technical Support

SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located throughout
the world. They can answer questions about the system or any technical issues that might arise. For more
information, visit the SCIEX website at sciex.com.

Documentation Symbols and Conventions

The following symbols and conventions are used throughout the guide.

DANGER! Danger signifies an action which leads to severe injury or death.

TripleTOF® 5600/5600+ System System User Guide
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Operational Precautions and Limitations

WARNING! Warning signifies an action that could cause personal injury if precautions
are not followed.

CAUTION: Caution signifies an operation that could cause damage to the system or
corruption or loss of data if precautions are not followed.

Note: Note emphasizes significant information in a procedure or description.

Tip! Tip provides useful information that helps apply the techniques and procedures in the text for a specific
need and provides shortcuts, but is not essential to the completion of a procedure.

Related Documentation

To find software product documentation, refer to the release notes or software installation guide that comes with
the software. Documentation for the hardware products can be found on the Customer Reference DVD that

comes with the system or component.

For the latest versions of the documentation, visit the SCIEX website at sciex.com.

System User Guide TripleTOF® 5600/5600+ System
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Principles of Operation 2

The TripIeTOF® 5600" system is designed for the qualitative and quantitative analysis of chemical species.

This section includes information about the mass spectrometer and the Analyst® TF software. Refer to the ion
source Operator Guide for an overview of the ion source.

For information on the computer and software, refer to the Software Installation Guide for the Analyst® TF
software.

WARNING! Lifting Hazard. Do not move the system. Risk of personal injury
or system damage. If the system must be moved, then contact a Field Service
Employee (FSE).

System Overview

WARNING! Lifting Hazard. Follow established safe lifting procedures. Refer to the
Site Planning Guide for the weights of system components.

The TripIeTOF® 5600" system includes the following components:
e A TripIeTOF® 5600" mass spectrometer with a roughing pump.
A DuoSpray™ ion source. Refer to the DuoSpray™ lon Source Operator Guide.

e ASCIEX-supplied computer and monitor with the Analyst® TF software for instrument optimization, acquisition
method development, and data acquisi(’gion. For computer specifications and requirements, refer to the Software
Installation Guide for the Analyst TF software.

e The optional calibrant delivery system (CDS)

Hardware Overview

Figure 2-1 and Figure 2-2 show the mass spectrometer components and connections.

TripleTOF® 5600/5600+ System System User Guide
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Principles of Operation

Figure 2-1 Front and Right Side View
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Item [Description For more information...

1 Optional CDS Refer to the CDS Operator Guide.

2 DuoSpray™ ion source Refer to the DuoSpray™ lon Source for

TripleTOF® Systems Operator Guide.

3 Syringe pump Refer to Adjust the Integrated Syringe Pump
Position on page 26.

4 Mass spectrometer status LEDs Refer to Panel Symbols.

5 Communications bulkhead Contact an SCIEX Field Service Employee
(FSE).

6 Serial (RS-232) cable connection for the syringe pump | Contact an FSE.

System User Guide TripleTOF® 5600/5600+ System
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Principles of Operation

Item |Description

For more information...

7 USB cable connection for the USB-GPIB card

Contact an FSE.

8 InfiniBand cable connection for the TDC card

Contact an FSE.

Figure 2-2 Left Side View

Item |[Description

For more information...

1 Gas and vacuum bulkhead Contact an FSE.
2 Roughing pump vacuum connection Contact an FSE.
3 Calibrant control connection Refer to the CDS Operator Guide.

TripleTOF® 5600/5600+ System
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Item |Description For more information...
4 AUX 10 connection. The optional LC system start [ Contact an FSE.
signal connects to this port.
5 External control connection. This port is intended for | Contact an FSE.
future use.
6 Sources connection. Some ion sources connect to this | Contact an FSE.
port.
7 AC distribution panel Contact an FSE.
8 Instrument power switch Refer to Start Up the System on page 24.
9 Cover over circuit breaker Refer to Start Up the System on page 24. Use
the power switch rather than the circuit
breaker to shut down the system.
10 Mains supply connection Refer to Start Up the System on page 24.
1" Curtain Gas™ (nitrogen) supply connection Contact an FSE.
12 Gas 1 and Gas 2 (zero) supply connection Contact an FSE.
13 Source exhaust gas (zero air or nitrogen) supply Contact an FSE.
connection
14 CAD gas (nitrogen) supply connection Contact an FSE.
15 Source exhaust waste connection Contact an FSE.

Panel Symbols

Table 2-1 describes the mass spectrometer status LEDs.

Table 2-1 Panel Symbols

LED Color Name Description
!| ] Green Power Lit when the system is powered up.
Green Vacuum Lit when the correct vacuum level has been
v achieved. Flashing if the vacuum is not at the
correct level (during pump down and venting).

System User Guide
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Table 2-1 Panel Symbols (continued)

LED Color Name Description
Green Ready Lit when the system is in the Ready state. The
system must be in the Ready state to operate.

g Red Fault Lit when the system encounters a system fault.

After the system is turned on, all of the LEDs illuminate. The power LED remains lit. The other LEDs flash for two
seconds and then turn off. The vacuum LED starts flashing. After the correct vacuum level is achieved this LED
remains lit.

Theory of Operation

Mass spectrometry measures the mass-to-charge ratio of ions to identify unknown compounds, to quantify known
compounds, and to provide information about the structural and chemical properties of molecules.

The TripleTOF® 5600* system has a series of quadrupole fllters that transmit ions according to their mass-to-charge
(m/z) value. The first quadrupole in this series is the QJet” ion guide, which is located between the orifice plate
and the QO region. The QJet” ion guide does not filter ions, but focuses them before they enter the QO region. By
prefocusing the larger ion flux created by the wider orifice, the QJet” ion guide increases instrument sensitivity
and improves the signal-to-noise ratio. In the QO region, the ions are again focused before passing into the Q1
quadrupole.

The Q1 quadrupole sorts the ions before they enter the Q2 collision cell. The Q1 quadrupole works in two operational
modes:

® Passing all ions within a specified m/z range to the Q2 collision cell. This is a TOF MS scan. All ions are analyzed
by the TOF system.

® Passing one ion with a specified m/z ratio to the Q2 collision cell. This is a TOF MS/MS scan. Only the selected
ion is analyzed.

In the Q2 collision cell, the internal energy of the ions is increased though collisions with gas molecules to the
point that molecular bonds break, creating product ions. This technique allows users to design experiments that
measure the m/z ratio of product ions to determine the composition of the parent ions and to provide information
about the structural and chemical properties of the molecules.

After passing through the Q2 collision cell, the ions enter the TOF region for additional mass analysis. They reach
the detector at different times depending on their m/z ratio. In the detector, the ions create a current that is
converted into a voltage pulse. These voltage pulses are counted and the number of pulses is directly proportional
to the quantity of ions entering the detector. The mass spectrometer converts the voltage pulses to a signal and
then correlates the signal to the time it takes each ion to reach the detector. The signal represents the ion intensity
and the time to reach the detector represents a specific m/z value. The mass spectrometer shows this data as a
mass spectrum.

TripleTOF® 5600/5600+ System System User Guide
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Data Handling

The Analyst” TF software requires a computer running the Windows 7 (32- or 64-bit) operating system or the

Windows 10 (64-bit) operating system. The computer and the associated system software work with the system
controller and the associated firmware to control the system and data acquisition. During system operation, the
acquired data is sent to the Analyst™ TF software where it can be shown as either full mass spectra, intensity of

single or multiple ions over time, or total ion current over time.

TripleTOF® 5600/5600+ System
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Operating Instructions—Hardware 3

WARNING! Personal Injury Hazard. Follow the instructions in the documentation
when using the system. The protection provided by the equipment might be impaired
if the equipment is used in a manner not specified by SCIEX.

Start Up the System

c c WARNING! Electrical Shock Hazard. Make sure that the system can be

disconnected from the mains supply outlet in an emergency. Do not block
the mains supply outlet.

c é% WARNING! Lifting Hazard. Do not move the system. Risk of personal injury

or system damage. If the system must be moved, then contact a Field Service
Employee (FSE).

Note: Before operating the instrument, read the safety information in Operational Precautions and Limitations
on page 7.

Prerequisites

The site requirements specified in the Site Planning Guide are met. The Site Planning Guide includes
information on the mains supply and connections, compressed air, nitrogen, roughing pump, ventilation,
exhaust, and site clearance requirements. Contact us for a copy of the Site Planning Guide, if required.
For contact information, go to sciex.com/contact-us.

The source exhaust gas, compressed air, and nitrogen gases are connected to the mass spectrometer.

The 4 L source exhaust drain bottle is connected to the exhaust waste connection on the back of the mass
spectrometer and to the laboratory ventilation system.

The source exhaust hoses are securely clamped at the mass spectrometer, drain bottle, and ventilation
connections.

The instrument power switch is turned off and the mains supply cable is plugged into the mass spectrometer.

The mass spectrometer and roughing pump mains supply cables are plugged into the 200 VAC to 240 VAC
mains supply.

TripleTOF® 5600/5600+ System System User Guide
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Operating Instructions—Hardware

1. Turn on the roughing pump.

2. Remove the cover on the circuit breaker switch on the left side of the mass spectrometer, when viewed from
the front and then turn on the circuit breaker. Refer to Figure 2-2.

3. Replace the cover over the circuit breaker switch and then tighten the screw holding the cover until it is finger
tight.

4. Turn on the instrument power switch. Refer to Figure 2-2.
5. Turn on the computer.

6. Open the Analyst” TF software.

Shut Down the System

Some procedures require that the system be shut down. Others require that it also be vented. Follow these steps
to shut down and, if required, vent the system.

Note: If the gas tubing must be disconnected, then relieve the pressure in the gas lines before disconnecting
it.

Tip! If the mass spectrometer will not be used for a length of time, then leave it in Standby mode with the ion
source in place. If the mass spectrometer must be shut down, then follow these instructions. Do not turn off the
roughing pump until after the turbo pumps have spun down.

1. Complete or stop any ongoing scans.

CAUTION: Potential System Damage. Turn off the sample flow before shutting down
the system.

Turn off the sample flow to the system.
In the Analyst® TF software, deactivate the hardware profile, if it is active.
Close the software.

Turn off the instrument power switch on the left side of the instrument. Refer to Hardware Overview.

SANE A

(If required) Follow these steps to vent the system:

Note: Vent the system before performing a full cleaning of the vacuum interface, before cleaning the Q0
region, and before replacing the roughing pump oil. For more information contact the Qualified Maintenance
Person (QMP) or FSE.
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Note: Leave the ion source installed for proper venting.

a. Turn off the roughing pump. Allow the system to vent for 20 minutes.

7. Remove the cover on the circuit breaker switch on the left side of the mass spectrometer and then turn off the
circuit breaker. Refer to Figure 2-2.

8. Replace the cover over the circuit breaker switch and then tighten the screw holding the cover until it is finger
tight.

9. (If venting the system) Disconnect the roughing pump mains supply cable from the mains supply outlet.

Adjust the Integrated Syringe Pump Position

A & WARNING! Puncture Hazard. Take care when handling the syringe. The tip
of the syringe is extremely sharp.

c é@ WARNING! Puncture Hazard. Make sure that the syringe is seated properly
in the syringe pump and that the automatic syringe pump stop is adjusted
properly to avoid damaging or breaking the glass syringe. If the syringe
breaks, follow established safety procedures for sharps disposal.

1. Press the Release button on the right side of the syringe pump to lower the base and then insert the syringe.
Refer to Figure 3-1.

TripleTOF® 5600/5600+ System System User Guide
26 / 131 RUO-IDV-05-7040-B



Operating Instructions—Hardware

Figure 3-1 Lowering the Syringe
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Item Description
1 Syringe plunger
2 Release button. Press to raise or lower the base.

2. Make sure that the end of the syringe is flush against the base and that the shaft of the syringe rests in the
cutout.

3. Adjust the post so that it triggers the automatic syringe stop before the syringe plunger hits the bottom of the
glass syringe. Refer to Figure 3-2.
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Figure 3-2 Automatic Syringe Stop
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Item Description

1 Automatic syringe stop. After the post hits the automatic syringe stop,
the syringe pump stops.

2 Post. Adjust the height to prevent the syringe plunger from hitting the
syringe during sample infusion.

3 Post lock screw. Tighten the screw after the height of the post is adjusted.

4. Turn the side screws as shown in Figure 3-3 to secure the syringe.

TripleTOF® 5600/5600+ System System User Guide
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Figure 3-3 Syringe Pump Screws

5. Inthe Analyst® software, on the Navigation bar, double-click Manual Tuning.
6. Click Start Syringe.
7. To stop the syringe pump, click Stop Syringe.

Reset the Syringe Pump

If the Analyst® TF software stops communicating with the syringe pump, then reset the syringe pump.

e Use a paper clip or similar tool to press the reset button, shown in Figure 3-4 on page 30.
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Figure 3-4 Reset Button
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Operating Instructions — Sample
Workflows

Table 4-1 Instrument Setup

Step

To do this...

Find the information in....

What does it do?

1

Create a hardware profile.

Create a Hardware Profile on page 34

Each hardware profile must
include a mass
spectrometer and other
devices, such as an LC
system. Only devices
included in the active
hardware profile can be
used when creating
acquisition methods.

Create projects to store data.

Create Projects and Subprojects on
page 42

Using projects and
subprojects facilitates data
management and makes
comparison of results
easier.

Optimize the mass
spectrometer.

Optimize the Mass Spectrometer on
page 47

This is the process of
optimizing the resolution
and mass spectrometer
parameters, and calibrating
the mass spectrometer to
obtain the best sensitivity
and performance from the
system.
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Table 4-2 Sample Acquisition Workflow

Step

To do this...

Find the information in....

What does it do?

1

Create projects to store data.

Create Projects and Subprojects on
page 42

Before starting an
experiment, decide where
to store the files related to
the experiment. Using
projects and subprojects
improves data management
and makes comparison of
results easier.

Create an acquisition method.

Operating Instructions — Acquisition
Methods on page 50

To analyze samples, create
an acquisition method for
the mass spectrometer and
any LC devices. An
acquisition method
indicates which peripheral
devices to use, when to use
them to acquire data, and
the associated parameters.

Create and submit a batch.

Add Sets and Samples to a Batch on
page 62 and Submit a Sample or Set
of Samples on page 65

After creating an
acquisition method, run
samples by creating an
acquisition batch and
submitting the batch to the
acquisition queue.

Run samples to acquire data.

Acquire Data on page 66

Running samples involves
managing the acquisition
queue and monitoring
instrument and device
status. To submit samples
and acquire data, use the
Queue Manager. The Queue
Manager shows queue,
batch, and sample status,
and facilitates management
of samples and batches in
the queue.
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Table 4-2 Sample Acquisition Workflow (continued)

Step

To do this...

Find the information in....

What does it do?

5

Analyze data in Explore mode.

Operating Instructions — Analyze and
Explore Data on page 74

In Explore mode, many
tools are available for
viewing and processing the
acquired data. Graphs can
be customized with peak
labels and captions, contour
plots can be shown, and
spectra can be saved in the
library.

Analyze data and print reports
using companion software.

MultiQuant™ software/PeakView”
software

Use the MultiQuant™
software or PeakView”
software to analyze data.
For more information, refer
to the documentation that
comes with the software.

Table 4-3 Experienced User Workflow

spectrometer.

Step |To do this... Find the information in....
1 Mass calibrate the instrument. | Mass Calibration Tutorial located in Start > Programs > SCIEX
> Analyst® TF > Software Guides.
2 Optimize the mass Manual Optimization Tutorial located in Start > Programs >

SCIEX > Analyst® TF > Software Guides.
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Hardware Profiles and Projects 5

Hardware Profiles

A hardware profile tells the software how the mass spectrometer and the devices are configured and connected
to the computer. Multiple hardware profiles can be set up, but only one profile can be active at any time.

When a hardware profile is created in the Hardware Configuration Editor, the peripheral devices must be configured
so that the software can communicate with them. Configuring the peripheral devices requires two procedures:
setting up the physical connections and configuring the software to communicate with the peripheral devices.
When the software is installed, the driver required for each peripheral device is also installed. After the peripheral
devices are physically connected to the computer, set up the appropriate configuration information.

Each hardware profile must include a mass spectrometer. Before creating an acquisition method, make sure that
all devices to be used in the method are included in the hardware profile, including the syringe pump. The devices
configured in the active hardware profile and selected in the Add/Remove Device Method dialog are shown as
icons in the Acquisition method pane. Only peripheral devices included in the active hardware profile can be used
when creating acquisition methods.

For information about setting up the physical connections to the devices, refer to the Peripheral Devices®5etup
Guide. For a list of the supported devices, refer to the Software Installation Guide for the Analyst TF
software.

Create a Hardware Profile

The user can create multiple hardware profiles, but only one profile can be active at any time.

1. On the Navigation bar, under Configure, double-click Hardware Configuration.
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Figure 5-1 Hardware Configuration Editor Dialog

[ Hardware Configuration Editor @ﬁ
Hardware Profiles:
[ Hew FPrafile... ]
| WiewProfile.. |
Delete Profile

[ Deactivate Prafile ]

[.i‘-.vailalgle Devices... ]

[ Cloze ]

[ Hep |

2. In the Hardware Configuration Editor dialog, click New Profile.
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Figure 5-2 Create New Hardware Profile Dialog

Create Mew Hardware Profile @

Profile Mame: |

Devices in current profile:

| Add Device...

Delete Device

Setup Device...

o

3. Type a name in the Profile Name field.
4. Click Add Device.
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Figure 5-3 Available Devices Dialog

Available Devices @

Device Type:
[ b azz Spectrometer - ]

Devices:
i b azz Spectrometer TrpleTOF 5600

b azs Spectrometer TrpleTOF 4600
b azs Spectrometer TrpleTOF BEO0

[ Ok ] [ Cancel ]

In the Available Devices dialog, in the Device Type field, Mass Spectrometer is the preset value.

5. In the Devices list, select the appropriate mass spectrometer and then click OK to return to the Create New
Hardware Profile dialog.

6. Click Setup Device.

7. (Optional) To configure mass spectrometers that use the integrated syringe pump, on the Configuration
tab, select the Use integrated syringe pump check box.
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Figure 5-4 Configuration Tab with CDS and Syringe Pump Configured

Mass Spectrometer @

Configuration | Communication

Alias:

Synchronization Trigger
@ Active low
() Active high

Mote: Scanning will be triggered by a 0 V signal i the
Active Low synchronization trigger is selected.

Settings for Integrated Devices
Ise calibrant delivery system (CDS)

[¥]ise integrated syringe pump: | Corfigure Pump

DuoSpray lon Source Switching Valve Courter

8. (Optional) To configure the mass spectrometer for the CDS, on the Configuration tab, select Use calibrant
delivery system (CDS).

9. (Optional) Select additional features on the Configuration and Communication tabs as required.
10. Click OK to return to the Create New Hardware Profile dialog.

11. Click Add Device and then add and set up each device that is used with the mass spectrometer. Refer to
Add Devices to a Hardware Profile on page 39.

12. Click OK in the Create New Hardware Profile dialog.

13. Click the hardware profile to be activated in the Hardware Configuration Editor.
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14. Click Activate Profile.

The check mark turns green. If a red x is shown, then there is an issue with the hardware profile activation.

Tip! A hardware profile need not be deactivated before another is activated. Click a hardware profile and
then click Activate Profile. The other profile is deactivated automatically.

15. Click Close.

Add Devices to a Hardware Profile

Devices must be configured to enable the software to communicate with them. When the software is installed,
the driver required for each device is also installed. After the devices are physically connected to the computer,
configure them.

1.

Open the Hardware Configuration Editor.

2. Inthe Hardware Profiles list, deactivate the hardware profile.
3. Click Edit Profile.

4.
5

Click Add Device.

. In the Available Devices dialog, in the Device Type list, select the device and then click OK.

System User Guide TripleTOF® 5600/5600+ System
RUO-IDV-05-7040-B 39/ 131



Operating Instructions — Hardware Profiles and Projects

Figure 5-5 Available Devices Dialog

Available Devices @

Device Type:

bdazz Spectrometer -

dasz 5pectrometer
Purmp
Autozampler
Colurnn Owven
"W alve

Detectar
&40 Corvverter
Integrated Syztem
Software Application

] ] [ Cancel

6. Click OK.
7. Select the device from the Devices list and then click OK.

8. Click Setup Device.

A dialog containing configuration values for the device opens.

9. (Optional) On the Communication tab, in the Alias field, type a name or other identifier for the device.

Note: For devices using serial communication, make sure that the serial port selected matches the serial
port to which the device is physically connected.

Note: The Alias field might also be referred to as the Name box and might be found on another tab under
Alias.

o |[f the device uses a Serial Port as a communication interface, then in the COM Port Number list,
select the COM port to which the device is connected.
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o |f the device uses Ethernet as a communication interface, then type the IP Address assigned to the
device by the administrator or use the corresponding Host Name for the address.

e |fthe device uses GPIB Board as a communication interface, then do not change the settings for the GPIB
board.

The rest of the preset values for the device are probably appropriate. Do not change them. For information
about the Configuration and Communication tabs, refer to the Help.

10. To restore the device preset values, on the Communication tab, click Set Defaults.

11. To save the configuration, click OK.

12. Repeat step 4 to step 11 for each device.

13. Click OK in the Create New Hardware Profile dialog.

14. To activate the hardware profile, in the Hardware Configuration Editor, click the hardware profile.
15. Click Activate Profile.

The check mark turns green. If a red x is shown, then there is an issue with the hardware profile activation.
For more information, refer to Troubleshoot Hardware Profile Activation on page 41.

Tip! An active hardware profile does not have to be deactivated before another one is activated. Click an
inactive hardware profile and then click Activate Profile. The other profile is deactivated automatically.

16. Click Close.

Troubleshoot Hardware Profile Activation

If a hardware profile fails to become active, then a dialog opens indicating which device in the profile failed. A
device might fail to activate because of communications errors.

1. Read the error message generated. Depending on the message, there might be an issue with a device or how
the communication is set up.

2. Verify that the device has power and is turned on.
3. Verify that the COM port assigned to the device is correct.

4. Verify that the communication settings for the device (for example, dip switch settings) are set correctly and
match the settings on the Communication tab.

5. Turn off the device.
6. Wait 10 seconds.

7. Turn on the device.

Wait until all device power-up activities are complete before trying to activate the hardware profile again.
Some devices might require 30 seconds or more to complete the power-up activities.
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8. Activate the hardware profile.
9. If the issue persists, then delete the failing profile and create a new one.

10. If the issue still persists, then contact technical support.

Projects and Subprojects

Before beginning an experiment, decide where to store the files related to the experiment. Use projects and
subprojects for each experiment to better manage data and compare results. For example, use subprojects to store
the results for specific dates.

Create Projects and Subprojects

To use a subproject structure within a project, create the subproject structure when the project is created.

1. Click Tools > Project > Create Project.
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Figure 5-6 Create New Project/Subproject Dialog
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Note: A new subproject cannot be created for a project that was not originally created with a subproject.

No

. Type a project name in the Project name field.

w

. (Optional) To use subprojects, select the required folders and then use the arrow buttons to move them to the
Subproject folders list.

4. (If subprojects are used) In the Subproject name field, type a name for the first subproject or use the existing
date.

(O]

. (Optional) To use this project and subproject folder organization for all new projects, select the Set
configuration as default for new projects check box.
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All new projects are created with this folder configuration.
6. Click OK.

Create Subprojects

Subprojects can only be created in a project that has an existing subproject structure.

1. On the Project tool bar, from the Project list, select the project.

2. Click Tools > Project > Create Subproject.

3. In the Subproject name box, type a name for the subproject or use the existing date.
4. Click OK.

Copy Subprojects

A subproject can be copied from another project that has existing subprojects. If the copied subprojects contain
folders that also exist in the project folder, then the software uses the project level folders.

1. Click Tools > Project > Copy Subproject.

The Copy Subproject dialog is shown.

Click Browse to navigate to the subproject source.
Click OK.

Select the subproject from the Source Subproject list.
Click Browse to navigate to the subproject destination.
Type the name in the Target Subproject field.

Click OK.

Do one of the following:

© N o v kB~ W N

¢ To copy all folders and files from the Subproject Source into the Subproject Destination, select
the Copy Contents check box.

¢ To copy only the folders in the same structure into the Subproject Destination, make sure that the
Copy Contents check box is cleared.

9. Click Copy.

Switch Between Projects and Subprojects

¢ On the software tool bar, from the project list, click the required project or subproject.
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Figure 5-7 Project List
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The project list in this figure shows the APl Instrument, Default, and Example folders.

Installed Project Folders
Three project folders are installed with the software: APl Instrument, Default, and Example.

API Instrument Folder

The API Instrument folder is unique and very important to the correct functioning of the mass spectrometer. The
API Instrument folder contains the information required for tuning and calibrating the mass spectrometer. This
information includes parameter settings files, reference files, instrument data files that contain calibration and
resolution information, and the acquisition methods used during automatic tuning. The API Instrument folder also
contains data files for manual tuning runs that were performed using the Start button rather than the Acquire
button. These data files are saved automatically in the APl Instrument folder in the Tuning Cache folder and named
with the date and time they were created. The Tuning Cache folder is automatically cleared periodically.

Default Folder
The Default folder contains folders that are present in new projects and serves as a template for new projects.
Example Folder

The Example folder contains sample methods and data files. Users can practice working with the Explore mode
using the example data files
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Back Up the API Instrument Folder

Back up the API Instrument folder regularly and after routine maintenance has been performed.

e Copy the API Instrument folder, paste it to a different location, preferably to another computer, and then
rename the folder. Use the date and a mass spectrometer reference if there is more than one mass spectrometer
when the folder is named. For example, API Instrument_instrument mode/3_010107

Recover the API Instrument Folder

Back up the API Instrument folder regularly and after routine maintenance has been performed.
1. Rename the current API Instrument folder.

2. Copy the backup folder into the Projects folder.

3. Change the name of the backup folder to API Instrument.
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Run the Verify Performance Only option at any time. However, tune the instrument only if a loss of sensitivity
or resolution is noticed. For more information about tuning and calibration, refer to the Advanced User Guide.

For tuning the system, use the following solutions that come with the installation kit:

For positive mode:

e For optimizing TOF MS - Product lon High Resolution or Product lon High Sensitivity, use the Tuning Solution.
e For Q1 calibration, use the PPG POS solution.

In negative mode:

e For optimizing TOF MS - Product lon High Resolution or Product lon High Sensitivity, use Taurocholic acid.

Note: We recommend that after using the Taurocholic acid, repeat the channel alignment using the PPG
POS solution.

e For Q1 calibration, use the PPG POS solution.

Tip! Perform maintenance tasks regularly to make sure that the mass spectrometer is performing optimally.

Prerequisites

e The spray is stable and the correct tuning solution is being used.

e A printer is configured.

Required Materials

¢ Tuning solutions that are supplied in the Standards Chemical Kit shipped with the system. If required, a new
kit can be ordered from SCIEX. Refer to Recommended Calibration lons.

e Gas-tight syringe (1.0 mL recommended)

e Red PEEK sample tubing.

Optimize the Mass Spectrometer

The following procedure describes how to verify the performance of the mass spectrometer. For more information
about using the other instrument performance options, refer to the Help.
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1. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.

2. Run a TOF MS or Product ion scan type and confirm that there is a stable TIC and that the peaks of interest
are present in the spectrum..

3. On the navigation bar, under Tune and Calibrate, double-click Instrument Optimization.

The Instrument Optimization dialog opens.

4. Select a tuning solution. Make sure that the tuning solution matches the reference table.

5. The Verify Performance Only check box is preselected. Click Next.
For this example, leave this option selected. If the report indicates that the instrument needs tuning, then run
Instrument Optimization again and select one or more scan modes to optimize.

6. Make sure that the ion source and syringe parameters are suitable.

Note: Users can also use the CDS to inject the solution. Make sure the tuning solution matches the
configuration in the reference table. Set the appropriate flow rate and then click CDS Inject.

Note: Make sure that the correct Calibrant Valve Position is selected in the Reference Table Editor for the
chosen reference table. CDS can select from up to four different positions, A to D.

7. Click GO.

The Verifying or Adjusting Performance screen opens. After the process has completed, the Results
Summary opens. For more information, refer to the Help.

About the Verifying or Adjusting Performance
Dialog

The top left corner shows the part of the instrument that is being tuned.

The Current Spectrum graph shows the spectrum of the current scan, the optimal scan selected by the software,
or the scan at the current parameter value when the software results are viewed in interactive mode.

The Instrument Optimization Decision Plots, in the top right graph, dynamically show the intensity versus voltage
curves of the parameters that are currently being optimized.

Results Summary

The Results Summary is a record of any instrument settings changes that were made by the Instrument Optimization
wizard.
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Figure 6-1 Results Summary
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The Results Summary is automatically saved in the following path: <drive>:\Analyst Data\Projects\API
Instrument\Data\lnstrument Optimization\yyyy-mm-dd\results.doc, where yyyy-mm-dd is the date on which the
report was created. Users can print the Results Summary or open a previously saved Results Summary.
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An acquisition method consists of experiments and periods. Use the Acquisition Method Editor to create a sequence
of periods and experiments for the instrument and devices.

An acquisition method consists of the method for the mass spectrometer and for liquid chromatography (LC)
devices. Users can easily create an acquisition method using the Method Wizard.

The Acquisition Method Editor can also be used to create acquisition methods and to add a sequence of periods
and experiments for the instrument and devices.

Use the SWATH” acquisition feature, available in both the Method Wizard and the Acquisition Method Editor, to
create SWATH® acquisition methods. Also, SWATH® Variable width window methods can be created using the
Method Wizard or Acquisition Method Editor. For more information, refer to the Advanced User Guide,
Analyst® Help, and Method Wizard Help.

We recommend that only users who are proficient in method development create or modify acquisition and
quantitation methods. Refer to the Laboratory Director’s Guide for more information about roles and security.

Create an Acquisition Method Using the Acquisition
Method Editor

Tip! If users are creating a new acquisition method file from an existing file, then some or all of the peripheral
device methods in the acquisition method might be used.

Only devices configured in the active hardware profile appear in the Acquisition method pane. Any devices added
to the hardware profile must also be added to existing acquisition methods. For more information about devices,
refer to the Peripheral Devices Setup Guide.

1. Make sure that a hardware profile containing the mass spectrometer and peripheral devices is active.

On the Navigation bar, under Acquire, double-click Build Acquisition Method.

Select a Synchronization Mode on the Acquisition Method Properties tab.

(Optional) Select the Auto-Equilibration check box and then type the required equilibration time, in minutes.
Click the Mass Spec icon in the Acquisition method pane.

Select a Scan type on the MS tab.

Type values in the fields as required. Refer to Parameters on page 55.

On the Advanced MS tab, type values in the fields as required.

© N o v kB~ W N
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9. On the MS tab, click Edit Parameters.

10. On the Source/Gas tab, specify values in the fields as required.

11. On the Compound tab, specify values in the fields as required and then click OK.
12. Click a device icon and then select the parameters for the device.

13. Add any additional periods and experiments. Refer to Add an Experiment on page 51 and Add a Period on
page 51.

14. Click File > Save.

Add an Experiment

1. In the Acquisition method pane, on the period where the experiment is to be added, right-click and then click
Add experiment.

Figure 7-1 Add Experiment

Arquisition method

=M Acquisition Method
--4% Mass Spec 0.000 min
S~ Period 0.000 min
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. Add experiment

Add IDA Criteria Level
Copy this experiment

Delete this experiment

An experiment is added below the last experiment in the period.

Note: An experiment cannot be inserted between experiments, IDA criteria, or periods. Users can only add
an experiment at the end of the period.

2. Inthe MS tab, select the appropriate parameters.

Add a Period

¢ In the Acquisition method pane, right-click the Mass Spec icon, and then click Add period.

A period is added below the last period created.
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Note: Users cannot use multiple periods in an IDA experiment.

Copy an Experiment into a Period

1. Open a multi-period method.

2. In the Acquisition method pane, press Ctrl, and then drag the experiment to the period.

The experiment is copied below the last experiment in the period.

Copy an Experiment within a Period

Use this procedure to add the same or similar experiments to a period if most or all of the parameters are the
same.

¢ Right-click the experiment and then click Copy this experiment.

A copy of the experiment is added below the last experiment created. This is useful when the same or similar
experiments are added to an acquisition method.

Create an Acquisition Method using the Method
Wizard

The acquisition method can be saved in an existing project.

Tip! To copy the Method Wizard template methods into the Acquisition Methods folder in the project
folder, select the Copy method templates check box in the Create New Project or Subproject dialog.
To open this dialog, click Tools > Project > Create Project or Create Subproject.

1. Make sure that a hardware profile containing the mass spectrometer and peripheral devices is active.
2. On the software toolbar, make sure that the appropriate project is selected.

3. On the Navigation bar, in Acquire mode, double-click Method Wizard.

The Method Wizard opens.

Tip! Move the cursor over the interface to view tool tips and procedures.

4. Select TOF MS (+) from the Choose MS Method list.
5. Select the LC method that was created for the hardware profile from the Choose LC Method list.
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Type a name for the method and then press Enter.

Click Next.

On the lon Source Parameters tab, verify the values, editing them if necessary, and then click Next.
On the TOF MS tab, verify the values, editing them if necessary, and then click Finish.

w L N o

Tip! If required, users can further edit the acquisition method using the Acquisition Method Editor.
In Acquire mode, click File > Open and then open the method that was created using the Method
Wizard.

Next steps: The newly created acquisition method can now be used to acquire data for preliminary analysis.

Scan Techniques

The system is a versatile and reliable system for performing liquid chromatography mass spectrometry analysis
on liquid sample streams to identify, quantify, and examine compounds.

The system uses the following mass spectrometry techniques to analyze samples:
e Two modes of single mass spectrometry (MS):

e Quadrupole-based single mass spectrometry (for Q1 calibration only)

e Time-of-flight-based single mass spectrometry
e Two modes of tandem mass spectrometry (MS/MS):

® Product ion mass spectrometry

® Precursor ion mass spectrometry

Single Mass Spectrometry

Single mass spectrometry (MS) is used to analyze charged molecules to find the molecular weight and amount of
detected ions. Individual ions detected by MS can indicate the presence of a target analyte.

Quadrupole-Based Single Mass Spectrometry

In a quadrupole-based single mass spectrometry (Q1 MS) scan, the system functions as a traditional quadrupole
mass spectrometer. In this mode, the system generates single mass spectrometric information using the first
quadrupole (Q1) section of the instrument.
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Time-of-Flight Single Mass Spectrometry

In a time-of-flight single mass spectrometry (TOF MS) scan, the system generates mass spectrometric information
by pulsing ions into a flight tube and recording their precise arrival time at the detector. lons with a greater
mass-to-charge ratio take longer to travel the flight tube.

Tandem Mass Spectrometry

The technique of MS/MS is well-suited to mixture analysis because the characteristic product ion spectra can be
obtained for each component in a mixture without interference from the other components, assuming that the
product ions have a unique m/z ratio.

Use MS/MS for targeted analysis by monitoring specific precursor/product ions while the sample is eluting. This
type of analysis is more specific than single MS, which only discriminates on the basis of the mass-to-charge ratio.

Product lon Mass Spectrometry

In a product ion scan (Product lon), the system generates mass spectrometric information by selecting a particular
precursor ion window in Q1, fragmenting in Q2 (a collision cell) and pulsing the ions (fragment ions) into a flight
tube and recording their precise arrival time at the detector. Product ions can provide information on the molecular
structure of the original (precursor) ions.

Precursor lon Mass Spectrometry

In a precursor ion scan, the system detects precursor ions that generate a specific product ion. The instrument
uses Q1 in mass resolving mode to scan over the mass range of interest, while the TOF section records product
ion spectra for each precursor ion. The Q1 mass spectrum shows all precursor ions that produce the product ion
of interest.

About Spectral Data Acquisition

Spectral data can be acquired in one of the modes described in Table 7-1.

Spectral Data can only be acquired from Q1 and Precursor lon scan types.
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Table 7-1 Spectral Data

Mode

Description

Profile

The preset value is 0.1 Da. Profile data is the data generated by the mass
spectrometer and corresponds to the intensity recorded at a series of evenly
spaced discrete mass values.For example, for the mass range 100 Da to 200
Da and step size 0.1, the instrument scans from 100 Da to 200 Da in 0.1 Da
increments (for example, 100.0, 100.1, 100.2, 100.3... up to 200.0).

Peak Hopping

The preset value is 1.0 Da. Peak Hopping is a mode of operating a mass
spectrometer in which large steps (approximately 1 Da) are made. It has the
advantage of speed (fewer data steps are made) but with the loss of peak
shape information.

Parameters

The working parameters are the set of instrument parameters currently being used.

e Source and gas parameters: These parameters can change depending on the ion source used.

e Compound parameters: These parameters consist mostly of voltages in the ion path. Optimal values for
compound-dependent parameters vary depending on the compound being analyzed.

® Resolution parameters: These parameters affect the resolution and calibration.

e Detector parameters: These parameters affect the detector. The Multi-Channel Plate is the detector in a TOF
instrument and consists of four channels for ion detection. The total of the channels equals the ion intensity.
This parameter can be optimized using Instrument Optimization.

The following figure shows the location of the parameters on the ion optics path.
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Figure 7-2 lon Optics Path and Parameters

= == I

The optimal heater temperature depends on
the type of sample being analyzed and the
solvent used. If the heater temperature is
too high, the signal degrades. Typically,
heater temperatures are in the 130 °C to
180 °C range. The maximum heater
temperature that can be set is 250 °C, but
this is too high for most applications.

Location |Parameter |Parameter [Use Scan Type
Type

1 lonSpray Source and gas [The ISVF parameter affects the stability of |All
Voltage the spray and hence the signal sensitivity.
Floating This is the voltage applied to the needle that
(ISVF) sprays the sample.

1 Interface Source and gas | The IHT parameter controls the temperature | All
Heater of the NanoSpray® interface heater and is
Temperature only available if the NanoSpray® ion source
(IHT) and interface are installed.

TripleTOF® 5600/5600+ System

56 / 131

System User Guide
RUO-IDV-05-7040-B




Operating Instructions — Acquisition Methods

Location |Parameter |Parameter [Use Scan Type
Type
1 lon Source  [Source and gas [The GS1 parameter controls the nebulizer |All
Gas 1 (GS1) gas for both the TurboIonSpray® and APCI
probes. The GS1 parameter controls the
nebulizer gas for the TurbolonSpray” probe.
1 lon Source  [Source and gas | The GS2 parameter controls the heater gas | All
Gas 2 (GS2) for the TurboIonSpray® probe. The GS2
parameter controls the heater gas for the
TurbolonSpray® probe and the nebulizer gas
for the APCI probe.
1 Temperature | Source and gas | The TEM parameter controls the All
(TEM) temperature of the heater gas for the
TurbolonSpray® probe or the temperature
of the APCI probe.
1 Curtain Gas |Source and gas | The CUR parameter controls the gas flow of | All
(CUR) the Curtain Gas™ interface. The Curtain
Gas™ interface is located between the
curtain plate and the orifice. It prevents the
contamination of the ion optics.
1 Declustering | Compound The DP parameter controls the voltage on [All
Potential the orifice, which controls the ability to
(DP) decluster ions between the orifice and the

QJet® ion guide. It is used to minimize the
solvent clusters that might remain on the
sample ions after they enter the vacuum
chamber, and, if required, to fragment ions.
The higher the voltage, the higher the
energy imparted to the ions. If the DP
parameter is too high, then unwanted
fragmentation might occur.

Use the preset value and optimize for the
compound.
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Location

Parameter

Parameter
Type

Use

Scan Type

CAD Gas

Source and gas

The CAD parameter controls the pressure of
CAD gas in the collision cell. The collision
gas helps to focus the ions as they pass
through the collision cell; the preset for the
CAD parameter is in fixed mode. For MS/MS
scan types, the CAD gas helps to fragment
the precursor ions. When the precursor ions
collide with the collision gas, they dissociate
to form product ions.

Use the preset value and optimize for the
compound.

All

Collision
Energy (CE)

Compound

The CE parameter controls the potential
difference between the QO region and the
Q2 collision cell. It is used only in MS/MS
scan types. This parameter is the amount of
energy that the precursor ions receive as
they are accelerated into the Q2 collision
cell, where they collide with gas molecules
and fragment.

Use the preset value and optimize for the
compound.

Collision
Energy
Spread (CES)

Compound

The CES parameter, in conjunction with the
CE parameter, determines which three
discreet collision energies are applied to the
precursor mass in an Product lon scan when
CES is used. The collision energy is ramped
from low to high. For example, in positive
mode, the collision energy will be ramped
from CE — CES to CE + CES. By entering a
CES value, collision energy spread is
automatically turned on.

Use the preset value and optimize for the
compound.

TOF MS/MS
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Location

Parameter

Parameter
Type

Use

Scan Type

lon Release
Delay (IRD)

Compound

The amount of time in milliseconds before
the ion pulse. The default (11 msec) is
calculated based on the TOF masses and
can be adjusted by the operator. The range
is typically 6 msec to 333 msec.

This parameter is optimized using
Instrument Optimization wizard if the
Enhanced lon option is selected in the
Advanced options. In general, the default
values do not have to be changed.

MS/MS only,
Enhanced

lon Release
Width (IRW)

Compound

This is the width, or duration, of the ion
pulse in milliseconds and is calculated based
on the IRD. The range is typically 5 to 328
msec with a default value of 10 msec.

This parameter is optimized using the
Instrument Optimization wizard if the
Enhanced lon option is selected in the
Advanced options. In general, the default
values do not have to be changed.

MS/MS only,
Enhanced

MCP (CEM)

Detector

The CEM parameter controls the voltage
applied to the detector. The voltage affects
the detector response.

All
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CAUTION: Potential System Damage. If the HPLC system connected to the mass spectrometer
are not controlled by the software, then do not leave the mass spectrometer unattended
while in operation. The liquid stream from the HPLC system can flood the ion source when
the mass spectrometer goes into Standby mode.

Set Queue Options

The queue goes one-by-one through the list, acquiring each sample with the selected acquisition method. After
all of the samples have been acquired, the queue stops and the mass spectrometer goes into Standby mode. In
Standby mode, the LC pumps and some instrument voltages are turned off.

The user can change the length of time the queue runs after the last acquisition has finished, before the Analyst”
TF software puts the mass spectrometer into Standby mode. For information about the other fields in the Queue
Options dialog, refer to the Help.

1. On the Navigation bar, click Configure.

2. Click Tools > Settings > Queue Options.
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Figure 8-1 Queue Options Dialog
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. In the Max. Num. Waiting Samples field, set the maximum number of samples to a value that is greater
than the number of samples that will be submitted to the queue

. In the Max. Idle Time field, type the length of time the queue will wait after acquisition is completed before
going to Standby mode. The preset value is 60 minutes.

If gas cylinders are used, then adjust this time to make sure that the gas in the cylinders is not depleted.

If an LC method is used, then before the run is started, make sure that there is enough solvent in the reservoirs
for all of the sample runs at the primary flow rate and the maximum idle time.

. Select the Leave Mass Spec on in Standby check box to keep the mass spectrometer running after
analysis has been completed. This feature allows the heaters and gases to continue running, even after devices
have entered Idle state, so that the ion source and entrance to the mass spectrometer are kept free of
contaminants.

. Select the Fail Whole Batch in Case of Missing Vial check box to fail the entire batch when a missing
vial is encountered. If this option is not selected, then only the current sample will fail and the queue will
continue to the next sample.

. Select the Fail Whole Batch if Auto Calibration Fails check box to stop the batch if auto calibration
fails.

. Select the Keep Calibration Data File check box to keep the calibration data file in a subfolder in the
Data folder of the project from which samples are being submitted.
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9. Select the Continue Whole Batch if Missing Sync found check box to continue acquiring the whole
batch when a missing sync signal is encountered. If this check box is not selected, then the current sample
fails and the queue does not proceed to the next sample when this signal is encountered.

Add Sets and Samples to a Batch

A set can consist of a single sample or multiple samples.

Note: For more information about adding quantitation information to a batch, refer to the Advanced User
Guide.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Batch.

Figure 8-2 Batch Editor Dialog

Somple | Locations | Guantiation | Subma

Select Mathod for Sample Set
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A et Acouisition )
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| samiple Name | Rack Code | Rack Position | Plate Code | Mate Position | Vial Position|  Data File | Inj.Volume ()]

2. In the Sample tab, in the Set list, type a name.
3. Click Add Set.
4. Click Add Samples to add samples to the new set.
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Figure 8-3 Add Sample Dialog
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5. In the Sample name section, in the Prefix field, type a name for the samples in this set.

6. To add incremental numbering to the end of the sample name, select the Sample number check box.

7. If the Sample number check box is selected, then in the Number of digits field, type the number of
digits to include in the sample name.
For example, if 3 is typed, then the sample names would be samplename001, samplename002, and
samplename003.

8. Inthe Data file section, in the Prefix field, type a name for the data file that will store the sample information.

9. Select the Set name check box to use the set name as part of the data file name.

10. Select the Auto Increment check box to increment the data file names automatically.

Note: The data for each sample can be stored in the same or a separate data file. The names of the data
file will have numerical suffixes starting from 1.

11. Type a name in the Sub Folder field.

The folder is stored in the Data folder for the current project. If the Sub Folder field is left blank, then the
data file is stored in the Data folder and a subfolder is not created.
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12. In the New samples section, in the Number field, type the number of new samples to add.
13. Click OK.

The sample table fills with the sample names and data file names.

Tip! Fill Down and Auto Increment options are available in the right-click menu after a single column
heading or several rows in a column are selected.

14. On the Sample tab, in the Acquisition section, select a method from the list.

Depending on how the system is set up, specific information for the autosampler must be entered. Even if the
injection volume is set in the method, the user can change the injection volume for one or more samples by
changing the value in the injection volume column.

Note: To use different methods for some of the samples in this set, select the Use Multiple Methods
check box. The Acquisition Method column is shown in the Sample table. Select the acquisition method
for each sample in this column.

15. To change the injection volumes from the volumes listed in the method, in the Inj. Volume (pL) column,
type the injection volume for each sample.

16. To set sample locations, do one of the following:

e Set Sample Locations in the Batch Editor on page 67
e Select Vial Positions Using the Locations Tab (Optional) on page 67

17. Click the Submit tab.

Note: The order of samples can be edited before the samples are submitted to the queue. To change the
order of samples, on the Submit tab, double-click any of the numbers at the far left of the table (a very
faint square box is shown), and then drag them to the new location.

18. If the Submit Status section contains a message about the status of the batch, then do one of the following:

e |f the message indicates that the batch is ready for submission, then proceed to step 19.

¢ |f the message indicates that the batch is not ready for submission, then make the changes as indicated by
the message.

19. After confirming that all of the batch information is correct, click Submit.

The batch is submitted to the queue and can be viewed in the Queue Manager.
20. Save the file.
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Submit a Sample or Set of Samples

Note: Run the sample again in the event of an abnormal termination during sample acquisition. If the abnormal
termination is caused by a power failure, then the temperature of the autosampler tray is not maintained and
sample integrity might be compromised.

1. Select one sample or a set of samples.
2. Click the Submit tab in the Batch Editor.

3. Ifthe Submit Status section contains a message about the status of the batch, then do one of the following:

o |f the message indicates that the batch is ready for submission, then proceed to the next step.

¢ If the message indicates that the batch is not ready for submission, then make the changes as indicated by
the message.

4. Click Submit.

Set Up Sample Calibration

The software can automatically schedule and execute the external auto calibration while samples are being acquired
in batch mode. This ensures good mass accuracy is maintained throughout the acquisition.

If the CDS is not configured, calibration is done using an autosampler and users must supply the calibration method
(*.dam) and the vial position of the calibrant sample.

1. In the Batch Editor, click the Calibrate tab.

2. Inthe Calibrate Every _ Samples field, type the number of samples to be acquired between calibration
samples.

3. From the Calibrant Reference Table, select a table from the list of all calibrant reference tables available
for the current polarity. Make sure that the selected reference table has the correct Calibrant Valve Position.

4. Set the CDS Inject Flow Rate.

When the batch is submitted, the calibration samples are inserted into the queue. Each set starts with a
calibration sample. The calibration method is named AnalystCal_ plus the acquisition method name (for
example, AnalystCal_TOF.dam). If the CDS is configured, the software automatically creates a calibration
method that matches the acquisition method that is used for the next sample in the queue. Calibration data
is saved to a separate data file for each calibration sample. The calibration data file along with the calibration
report is saved in the subfolder Cal Data and named with Cal plus the time stamp and calibration sample index
(for example, Cal200906261038341.wiff) if the Keep Calibration Data File was selected in the Queue Options
dialog. The calibration report is named with Cal plus the time stamp, calibration sample index, and the word
report (for example, Cal20130822154447030_report.txt). The report displays the peak finding criteria, the
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parameters, and the masses used for calibration. It informs the users whether the calibration succeeded. The
report also summarizes the parameters used for calibration.

Change Sample Order

The order of the samples can be edited before the samples are submitted to the Queue.

e On the Submit tab, double-click any of the numbers at the far left of the table (a very faint square box is
visible), and then drag them to the new location.

Acquire Data

The system must not be in Tune and Calibrate mode when sample acquisition is started. Also, if the system has
been previously run that day and has not yet been set to Standby mode, then sample acquisition will start

automatically.

1. Make sure that the column oven temperature is reached.

T

2. Make sure that the icon is not pressed in.

3. On the Navigation bar, click Acquire.

4. Click View > Sample Queue.

The Queue Manager opens with all submitted samples.

Figure 8-4 Queue Manager
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Item Description
1 The Reserve Instrument for Tuning icon should not be pressed in.
2 Queue status should be in Ready mode.
3 Queue Server should be in Normal. Refer to Queue States on page 70.

5. Click Acquire > Start Sample.
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Set Sample Locations in the Batch Editor

If an autosampler is used in the acquisition method, then the vial positions of the samples must be defined in the
acquisition batch. Define the location in the Sample tab or in the Locations tab. For more information about
creating batches, refer to Add Sets and Samples to a Batch on page 62.

1. In the Sample tab, from the Set list, select the set.

2. For each sample in the set, do the following if applicable:

¢ In the Rack Code column, select the rack type.

In the Rack Position column, select the position of the rack in the autosampler.

In the Plate Code column, select the plate type.

In the Plate Position column, select the position of the plate on the rack.

In the Vial Position column, type the position of the vial in the plate or tray.

3. Save the file.

Select Vial Positions Using the Locations Tab
(Optional)

1. Click the Locations tab in the Batch Editor.
Select the set from the Set list.

Select the autosampler from the Autosampler list.

> wnN

In the space associated with the rack, right-click and then select the rack type.

The plates or trays are shown in the rack.

5. Double-click in the white space labeled rack type. A visual sample rack layout is shown.

The appropriate number of rack spaces for the autosampler is shown in the graphic rack view.

6. Double-click one of the rectangles.

The circles depicting the wells or vials for the plate or tray are shown.

Tip! To see the corresponding vial number in the graphical representation, move the cursor over the sample
position. Use this information to confirm that the vial positions in the software match the vial positions in
the autosampler.
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7.

8.

Figure 8-5 Locations Tab
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Note: Depending on the autosampler being used, it might not be necessary to type details in additional
columns.

To select whether samples are marked by row or column, click the Row/Column selection selector button.

If the button shows a red horizontal line, then the Batch Editor marks the samples by row. If the button
shows a red vertical line, then the Batch Editor marks the samples by column.

Click the sample wells or vials in the order to be analyzed.

Tip! Click a selected well or vial again to clear it.

Tip! To fill in the samples automatically, press the Shift key while clicking the first and last vial within a
set. To perform multiple injections from the same vial, press the Ctrl key while clicking the vial location. The
red circle changes to a green circle.

Stop Sample Acquisition

When a sample acquisition is stopped, the current scan finishes before the acquisition is stopped.

1.
2.
3.

In the Queue Manager, click the sample in the queue after the point where acquisition should stop.

On the Navigation bar, click Acquire.

Click Acquire > Stop Sample.

The queue stops after the current scan in the selected sample is complete. The sample status in the Queue

Manager (Local) window changes to Terminated, and all other samples following in the queue are
Waiting.
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4. To continue processing the batch, click Acquire > Start Sample.

Batch Editor Right-click Menu

Right-click in the Batch Editor table to access the options.

Figure 8-6 Batch Right-Click Menu

Select Script |
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Delete Samples
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Menu Function

Open Opens a batch file.

Import From Imports a file.

Save As Batch Saves the batch with a different name.

Save As a Template |Saves the batch as a template.

Hide/Show Column | Hides or shows a column.

Save Column Settings | Saves the batch column settings.

Add Custom Column | Adds a custom column.

Delete Custom Deletes a custom column.

Column

Fill Down Copies the same data into the selected cells.

Autolncrement Automatically increments data into the selected cells.
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Menu Function

Delete Samples Deletes the selected row.

Select Autosampler | Selects an autosampler.

Queue States and Device Status

The Queue Manager shows queue, batch, and sample status. Detailed information about a particular sample
in the queue can also be viewed.

Tip! Click b to view the queue.

Queue States

The current state of the queue is indicated in the Queue Server.

Figure 8-7 Queue Server Indicator Showing Normal Mode

Queue Server

E3 g

Ready Harmal

Figure 8-8 Queue Server Indicator Showing Tune Mode

[ueue Server
" m
Feady Tune

The first icon indicates the queue state. The second icon indicates whether the queue is in Tune mode (for tuning)
or Normal mode (for running samples). Table 8-1 describes the icons and queue states.
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Table 8-1 Queue States

i =

FPauzed tarmal

Icons State Definition
Hueue Server Not Ready |The hardware profile is deactivated and the queue is not
E E accepting any sample submissions.
Mot Feady tHarmal
Queue Server Stand By The hardware profile has been activated, but all devices are
I@ #3 idle. Pumps are not running and gases are turned off.
Stand By M armal
Hueue Server Warming Up [ The mass spectrometer and devices are equilibrating, columns
i . age . .
IE Ig are being conditioned, the autosampler needle is being washed,
wWarming Up Norrmal and column ovens are reaching temperature. The duration of
equilibration is selected by the operator. From this state, the
system can go to the Ready state.
Dueue Server Ready The system is ready to start running samples and the devices
|§ = have been equilibrated and are ready to run. In this state, the
Feady Marmal queue can receive samples and will run after samples are
submitted.
Hueue Server Waiting The system will automatically begin acquisition when the next
E = sample is submitted.
W aiting M armal
Dueue Server PreRun The method is being downloaded to each device and device
I? = equilibration is occurring. This state occurs before the acquisition
FreRun Marmal of each sample in a batch.
Queue Server Acquiring | The method is running and data acquisition is occuring.
= =
Azquining I armal
ueue Server Paused The system has been paused during acquisition.

View Instrument and Device Status Icons

Icons representing the mass spectrometer and each device in the active hardware configuration are shown on the
status bar in the bottom right corner of the window. The user can view the detailed status of an LC pump to
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determine whether the LC pump pressure is appropriate or view the detailed status of the mass spectrometer to
confirm the temperature of the ion source.

Note: For each status, the background color can be red. A red background indicates that the device encountered

an error while in that state.

e On the status bar, double-click the icon for the device or mass spectrometer.

The Instrument Status dialog opens.

Table 8-2 Instrument and Device Status Icons

Status Icon

Background
Color

Description

dle & 2

Green or yellow

The device is not running. If the background color is
yellow, then the device should be equilibrated before
it is ready to run. If the background color is green, the
device is ready to run.

Error

Equilibrating @‘ 5 Green or yellow |The device is equilibrating.
Waiting & Green The device is waiting for a command from the software
or another device, or for some action by the operator.
Running @' Green The device is running a batch.
Aborting & Green The device is aborting a run.
Downloading @r Green A method is being transferred to the device.
Ready @‘ Green The device is not running, but is ready to run.
Red The device has encountered an error that should be

investigated.

Queue Right-click Menu

Right-click in the Queue table to access the options.
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Figure 8-9 Queue Manager Right-Click Menu
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Menu Function
Sample Details Opens the Sample Details dialog.
Reacquire Acquires a sample again.
Insert Pause Inserts a pause, in seconds, between two samples.
Delete Deletes either the batch or the selected samples.
Move Batch Moves the batch within the queue.
Sort Sorts on the preselected column.
Column Settings Changes the column settings.
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Use the sample files installed in the Example folder to learn how to view and analyze data using the most common
analysis and processing tools. For more information about the following topics, refer to the Advanced User
Guide:

Labeling graphs

Overlaying and summing spectra or chromatograms
Performing background subtractions

Smoothing algorithms

Working with smoothed data

Working with centroid data

Working with contour plots

Working with the fragment interpretation tool

Working with library databases and library records

Open Data Files

Tip! To turn off the automatic update on the mass spectrum, right-click the mass spectrum and then click Show
Last Scan. If there is a check mark beside Show Last Scan, then the spectrum will update in real-time.

1.

2.

On the Navigation bar, under Explore, double-click Open Data File.

The Select Sample dialog is shown.

In the Data Files list, navigate to the data file to open, select a sample, and then click OK.

The data acquired from the sample is shown. If data is still being acquired, then the mass spectrum, DAD/UV
trace, and TIC continue to update automatically.

Tip! To see an example data file, make sure that the Example project is selected. Open the TOF folder,
and then open the TOFMS PPGs3000.wiff file. In the Sample list, select TOFMS.
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Navigate Between Samples in a Data File

Note: If samples were saved in separate data files, then open each file individually.

Table C-5 on page 119 shows the navigation icons used in this procedure.

¢ Open a data file that contains multiple samples and then do one of the following:

e (lick the icon with the arrow pointing to the right to skip to the next sample in the data file.
e Click the icon with the arrow curving to the right to skip to a non-sequential sample.
¢ In the Select Sample dialog, from the Sample list, select the sample to view.

e Click the icon with the arrow pointing to the left to go to the previous sample in the data file.

View Experimental Conditions

The experimental conditions used to collect data are stored in the data file with the results. The information
contains the details of the acquisition method used: the MS acquisition method (that is, the number of periods,
experiments, and cycles) including instrument parameters and the HPLC device method (LC pump flow rate). In
addition, it also contains the MS resolution and mass calibration tables used for the sample acquisition. Table 9-1
shows the software functionality available when the user views the file information.

Note: If data is acquired from more than one sample into the same wiff file, then the file information pane does
not refresh automatically while scrolling through the samples. Close the file information pane and then reopen
it to view the details for the next sample in the wiff file.

¢ (Click Explore > Show > Show File Information.

The File Information pane opens below the graph.

Tip! To create an acquisition method from the File Information pane, right-click the File Information
pane and then click Save Acquisition Method.

Table 9-1 Right-click Menu for Show File Information Pane

Menu Function
Copy Copies the selected data.
Paste Pastes data.
Select All Selects all the data in the pane.
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Table 9-1 Right-click Menu for Show File Information Pane (continued)

Menu Function

Save To File Saves data as an rtf file.

Font Changes the font.

Save Acquisition Method Saves the acquisition method as a dam file.

Save Acquisition Method to | Opens the Specify Compound Information dialog. Select the IDs and molecular
CompoundDB weights to be saved in the compound database.

Delete Pane Deletes the selected pane.

Show Data in Tables

1. Open a data file.
2. Click Explore > Show > Show List Data.

The data is shown in a pane below the graph.
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Figure 9-1 Peak List Tab

3.0

B TIC of +TOF Product (309.2): from Sample 1 {Reserpine M3MS CE = 40V - 2} of ReserpineM5MS...

0.04

o.08 o002 010 0412 014 018 0418 020 022 024 029 028 030 032 034 0324

Time, min

TIC of + TOF Product (609.2): from Samplel (Reserpine M5SMS CE = 40V - 2) of ReserpineM5SMS CE=40V wiff (Ton Spray)

Data List | Peal List

Time {min}) Intensity (cps) % Max. Intensity
1 0.03363 27836e4 934721
2 0.05030 28107e4 94 3821
3 0.06697 27498e4 8923371
4 0.08363 2 8618e4 96.0981
5 010030 27683e4 929584
G 011697 27230e4 91.4372
T 0.13363 2.8470e4 95.6011
L] mAaArRMN2an TFTOATAA 02 A0

Table 9-2 Right-click Menu for Spectral Peak List Tab

Menu

Function

Column Options

Opens the Select Columns for Peak List dialog.

Save As Text

Saves the data as a .txt file.

Delete Pane

Deletes the selected pane.
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Table 9-3 Right-click Menu for Chromatographic Peak List Tab

Menu

Function

Show Peaks in Graph

Show the peaks in two colors in the graph.

IntelliQuan Parameters

Opens the Intelliquan dialog.

Save As Text

Saves the data as a txt file.

Delete Pane

Deletes the selected pane.

Show ADC Data

ADC (analog-to-digital converter) data is acquired from a secondary detector (for example from a UV detector
through an ADC card), and is useful for comparison with mass spectrometer data. To have ADC data available,
acquire the data and the mass spectrometer data simultaneously and then save it in the same file.

1. Make sure that the Example folder is selected.

2. On the Navigation bar, under Explore, double-click Open Data File.

The Select Sample dialog opens.

3. In the Data Files field, double-click Devices and then click Adc16chan.wiff.

4. In the Samples list, select a sample, and then click OK.

5. Click Explore > Show > Show ADC Data.

Figure 9-2 Select ADC Channel Dialog
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6. In the Channel list, select a channel, and then click OK.

The ADC data is shown in a new pane beneath the active pane.
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Show Basic Quantitative Data

1. Open a data file.
2. Click Explore > Show > Show List Data.

Figure 9-3 List Data
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3. In the Peak List tab, right-click and then select Show Peaks in Graph.

Peaks are shown in two colors.

4. To change the peak finding algorithm settings, right-click and then select either Analyst Classic Parameters
or Intelliquan Parameters, whichever is active.

5. (Optional) To remove the colored peaks, right-click in the Peak List tab and then clear Show Peaks in Graph.

Chromatograms

A chromatogram is a graphical view of the data obtained from the analysis of a sample. It plots the signal intensity
along an axis that shows either time or scan number. For more information about software functionality available
for chromatograms, refer to Table 9-6 on page 88.
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The software plots intensity, in counts per second (cps), on the Y-axis against time on the X-axis. Peaks above a
set threshold are labeled automatically. In the case of LC-MS, the chromatogram is often shown as a function of
time. Table 9-4 contains the a description of the types of chromatograms.

Refer to Table 9-8 on page 90 for more information about using the available icons.

Table 9-4 Types of Chromatograms

Types of Chromatograms | Purpose

TIC (Total lon Chromatogram) [A chromatographic view generated by plotting the intensity of all ions in a scan
against time or scan number.

When a data file is opened, it is preset to open as a TIC. If the experiment
contains only one scan, then it is shown as a spectrum.

If the MCA check box is selected during acquisition of the data file, then the
data file opens to the mass spectrum. If the MCA check box is not selected, then
the data file opens as the TIC.

XIC (Extracted lon An ion chromatogram created by taking intensity values at a single, discrete
Chromatogram) mass value, or a mass range, from a series of mass spectral scans. It indicates
the behavior of a given mass, or mass range, as a function of time.

BPC (Base Peak Chromatogram) [ A chromatographic plot that shows the intensity of the most intense ion within
a scan versus time or scan number.

TWC (Total Wavelength A chromatographic view created by summing all of the absorbance values in
Chromatogram) the acquired wavelength range and then plotting the values against time. It
consists of the summed absorbances of all ions in a scan plotted against time
in a chromatographic pane.

XWC (Extracted Wavelength [ A subset of TWC. An XWC shows the absorbance for a single wavelength or the
Chromatogram) sum of the absorbance for a range of wavelengths.

DAD (Diode Array Detector) | A UV detector that monitors the absorption spectrum of eluting compounds at
one or more wavelengths.

Show TICs from a Spectrum

¢ C(lick Explore > Show > Show TIC.

The TIC opens in a new pane.
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Tip! Right-click inside a pane containing a spectrum and then click Show TIC.

Show a Spectrum from a TIC

1. In a pane containing a TIC, select a range.

2. Click Explore > Show > Show Spectrum.

The spectrum opens in a new pane.

Tip! Double-click in the TIC pane at a particular time to show the spectrum.

Figure 9-4 Example of a TIC
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About Generating XICs

XICs can be generated only from single-period, single-experiment chromatograms or spectra. To obtain an XIC
from multi-period or multi-experiment data, split the data into separate panes by clicking the triangle under the
X-axis. Refer to Table 9-8 on page 90 for more information about using the available icons.

Several methods are available for extracting ions to generate an XIC, depending on whether chromatographic or
spectral data is used. Table 9-5 contains a summary of methods that can be used with chromatograms and spectra.

Table 9-5 Summary of XIC Generation Methods

Method Use with Use with Extraction
Chromatogram Spectrum
Selected range No Yes Extracts ions from a selected area in a
spectrum.
Maximum No Yes Extracts ions from a selected area in a spectrum

using the most intense peak in the selected
area. This option creates an XIC using the
maximum mass from the selected spectral
range.

Base peak masses Yes Yes Can be used only with Base Peak
Chromatograms (BPCs). Use the Use Base Peak
Masses command to extract ions results in an
XIC with a different colored trace for each mass.
If the selection includes multiple peaks, then
the resulting XIC will have an equal number of
colored traces, one for each mass.

Specified masses Yes Yes Extracts ions from any type of spectrum or
chromatogram. Select up to ten start and stop
masses for which to generate XICs.

Generate an XIC Using a Selected Range

1. Open a data file containing spectra.

2. Select arange by pressing the left mouse button at the start of the range, dragging the cursor to the stop point,
and then releasing the left mouse button.

The selection is indicated in blue.

3. Click Explore > Extract lons > Use Range.
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An XIC of the selection opens in a pane below the spectrum pane. The experiment information at the top of
the pane contains the mass range and the maximum intensity in counts per second.

Generate an XIC Using the Maximum Peak

1. Open a data file containing spectra.

2. Select arange in a spectrum.

The selection is indicated in blue.

3. Click Explore > Extract lons > Use Maximum.

An XIC of the maximum peak specified selection opens below the spectrum pane. The experiment information
at the top of the pane contains the mass range and the maximum intensity in counts per second.

Generate an XIC Using Base Peak Masses

1. Open a data file containing spectra.

2. In a BPC, select the peak from which to extract ions.

The selection is indicated in blue.

3. Click Explore > Extract lons > Use Base Peak Masses.

An XIC of the specified selection opens below the spectrum pane. The experiment information at the top of
the pane shows the mass range and the maximum intensity in counts per second.

Extract lon by Selecting Masses

1. Open a spectrum or chromatogram.

2. Click Explore > Extract lons > Use Dialog.
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Figure 9-5 Extract lons Dialog
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3. Type the values for each XIC to be created. If a stop value is not typed, then the range is defined by the start
value.

¢ |n the Start field, type the start value (lower value) for the mass range.

¢ In the Stop field, type the stop value (higher value) for the mass range.
4. Click OK.

An XIC of the selection opens below the chromatogram pane. The experiment information at the top of the
pane includes the masses and the maximum intensity in counts per second.

Generate BPCs

BPCs can be generated only from single-period, single-experiment data.

1. Open a data file.

2. Select an area within a TIC.

The selection is indicated in blue.
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3. Click Explore > Show > Show Base Peak Chromatogram.
The selections are shown in the Start Time and End Time fields.

Figure 9-6 Base Peak Chromatogram Options
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4. In the Mass Tolerance field, type the value to indicate the mass range used to find a peak. The software
finds the peak using a value twice the typed range (+ the mass value).

Type the intensity below which peaks are ignored by the algorithm in the Minimum Intensity field.
Type the mass that determines the beginning of the scan range in the Minimum Mass field.

Type the mass that determines the end of the scan range in the Maximum Mass field.

O N o WU

To set the start and end times, select the Use Limited Range check box and do the following:

¢ In the Start Time field, type the time that determines the start of the experiment.

¢ In the End Time field, type the time that determines the end of the experiment.

9. Click OK.

The BPC is generated in a new pane.
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Generate XWCs

An XWC is a wavelength chromatogram created by taking intensity values at a single wavelength, or by the sum
of the absorbance for a range of several wavelengths. Up to three ranges can be extracted from a DAD spectrum
to generate the XWC. Refer to Table 9-8 on page 90 for more information about using the available icons.

1. Open a data file that contains a DAD spectrum.

2. Right-click anywhere in the pane and then click Extract Wavelengths.

Figure 9-7 Extract Wavelengths Dialog
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3. Type Start and Stop values.
4. Click OK.

The XWC is shown in a pane below the DAD spectrum.

DAD Data

Like mass spectrometer data, DAD data can be viewed in chromatogram or spectrum form. Users can view the
DAD spectrum for a single point in time, or for a range of time as a Total Wavelength Chromatogram (TWC).

1. Open a data file containing data acquired with a DAD.

The TWC, which is analogous to a TIC, opens in a pane below the TIC.

2. In the TWC pane, click a point to select a single point in time, or highlight an area of the spectrum to select a
range of time.

3. Click Explore > Show > Show DAD Spectrum.

The DAD spectrum opens in a pane below the TWC. The Y-axis shows the absorbance and the X-axis shows
the wavelength.

TripleTOF® 5600/5600+ System System User Guide
86 / 131 RUO-IDV-05-7040-B



Operating Instructions — Analyze and Explore Data

Tip! If the pane with the TWC is closed, then click a point anywhere in the TWC to open it again. Click
Explore > Show > Show DAD TWC.

Generate TWCs

A TWC is a less commonly used chromatogram. It shows the total absorbance (mAU) as a function of time. The
TWC provides a way of viewing an entire data set in a single pane. It consists of the summed absorbances of all
ions in a scan plotted against time in a chromatographic pane. If the data contains results from multiple experiments,
then create individual TWCs for each experiment and another TWC that represents the sum of all experiments.

A TWC shows total absorbance (mAU) on the Y-axis plotted against time on the X-axis. Refer to Table 9-8 on page
90 for more information about using the available icons.

1. Open a data file that contains a DAD spectrum.
2. Click Explore > Show > Show DAD TWC.

The TWC is shown in a pane below the DAD spectrum.

Tip! Right-click inside the pane containing the DAD spectrum and then click Show DAD TWC.

Adjust the Threshold

The threshold is an invisible line drawn parallel to the X-axis of a graph that sets a limit below which the software
will not include peaks in a spectrum. The line has a handle, represented by a blue triangle to the left of the Y-axis.
Click the blue triangle to view a dotted line that represents the threshold. The threshold can be raised or lowered,
but changing the threshold value does not change the data. The software does not label any peaks in the region
that lies below the threshold.

1. Open a data file.

2. Do one of the following:

e To raise the threshold, drag the blue triangle up the Y-axis. To lower the threshold, drag the blue triangle
down.

e C(lick Explore > Set Threshold. In the Threshold Options dialog that opens, type the threshold value
and then click OK.

e (lick Explore > Threshold.

The graph updates to show the new threshold. Peak labeling and the peak list are also updated.

Tip! To view the current threshold value, move the pointer over the threshold handle.
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Chromatogram Panes

Table 9-6 Right-click Menu for Chromatogram Panes

Menu

Function

List Data

Lists the data points and integrates the peaks found in chromatograms.

Show Spectrum

Generates a new pane containing the spectrum.

Show Contour Plot

Shows a color-coded plot of a data set, where the color represents the intensity of
the data at that point. Only certain MS modes are supported.

Extract lons

Extracts a specific ion or set of ions from a selected pane and then generates a new
pane containing a chromatogram for the specific ions.

Show Base Peak
Chromatogram

Generates a new pane containing a base peak chromatogram.

Show ADC Data

Generates a new pane containing the ADC data trace, if acquired.

Show UV Detector Data

Generates a new pane containing the UV data trace, if acquired.

Spectral Arithmetic Wizard

Opens the Spectral Arithmetic Wizard.

Save to Text File

Generates a text file containing the data in a pane, which can be opened in Microsoft
Excel or other programs.

Save Explore History

Saves information about changes to processing parameters, also called processing
options, that were made when a wiff file was processed in Explore mode. The
processing history is stored in a file with an eph (Explore Processing History) extension.

Add Caption

Adds a caption at the cursor point in the pane.

Add User Text

Adds a text box at cursor point in the pane.

Set Subtract Range

Sets the subtract range in the pane.

Clear Subtract Range

Clears the subtract range in the pane.

Subtract Range Locked

Locks or unlocks the subtract ranges. If the subtract ranges are not locked, then each
subtract range can be moved independently. The subtract ranges are preset to locked.

Delete Pane

Deletes the selected pane.
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Spectra Panes

Table 9-7 Right-click Menu for Spectra Panes

Menu Function
List Data Lists the data points and integrates chromatograms.
Show TIC Generates a new pane containing the TIC.

Extract lons (Use Range)

Extracts a specific ion or set of ions from a selected pane and then
generates a new pane containing a chromatogram for the specific
ions.

Extract lons (Use Maximum)

Extracts ions using the most intense peak in a selected area.

Save to Text File

Generates a text file of the pane, which can be opened in Microsoft
Excel or other programs.

Save Explore History

Saves information about changes to processing parameters, also
called Processing Options, that were made when a wiff file was
processed in Explore mode. The processing history is stored in a file
with an eph (Explore Processing History) extension.

Add Caption

Adds a caption at the cursor position in the pane.

Add User Text

Adds a text box at the cursor position in the pane.

Show Last Scan

Shows the scan prior to the selection.

Select Peaks For Label

In this dialog, select the parameters to reduce peak labeling.

Re-Calibrate TOF

Opens the TOF Calibration dialog.

Abscissa (Time)

Changes the view to display TOF values on the x-axis.

Delete Pane

Deletes the selected pane.

Add a Record

Adds records and compound-related data, including spectra, to the
library. An active spectrum is required to perform this task.

Search Library

Searches the library without constraints or with previously saved
constraints.

Set Search Constraints

Searches the library using the criteria typed in Search Constraints
dialog.

Graphical Data Processing

Graphical data can be processed many ways. This section provides information and procedures for using some of

the most commonly used tools.
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Graphs

The same data can be examined in different ways. Data can also be kept for comparison purposes before performing
processing operations such as smoothing or subtraction.

A window contains one or more panes arranged in such a way that all the panes are fully visible and that they do
not overlap.

Panes might be of a variable or fixed size. Panes are automatically tiled within the window and are arranged into
column and row format. If the size of a window is changed, then the panes within the window change in size to
accommodate the new size. A window cannot be sized to the point where any of the panes become smaller than
their minimum size.

Two or more windows or panes containing similar data can be linked, for example, spectra with similar mass
ranges. As one pane or window is zoomed in, the other pane zooms in simultaneously. For example, the user can
link an XIC to the BPC from which the XIC was extracted. Zooming in the BPC also zooms the XIC, so that both
chromatograms show the same magnification.

Manage Data

Data can be compared or examined in different ways. Users might want to keep the data for comparison purposes
before performing processing operations such as smoothing or subtraction.

A window contains one or more panes, arranged in such a way that all the panes are fully visible and they do not
overlap.

Panes can be of variable or fixed size. Panes are automatically tiled within the window and are arranged into
column and row format. If window size is changed, then the panes within the window change in size to
accommodate the resizing. A window cannot be resized to the point where any of the panes would become smaller
than its minimum size.

Two or more windows or panes containing similar data can be linked, for example, spectra with similar mass
ranges. When the user zooms in one pane or window, the other pane zooms simultaneously. For example, the
user can link an XIC to the BPC from which it was extracted. Zooming in the BPC also zooms the XIC, so that both
chromatograms are shown with the same magnification.

e Use the following menu options or icons to manage data in graphs.

Table 9-8 Graph Options

To do this... use this menu option... ...or click this icon
Copy a graph to a new |Select the graph to copy. Click Explore > Duplicate 5,
window Data > In New Window.
Rescale a graph to its  [Select the graph. Click Explore > Home Graph. A
original size
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Table 9-8 Graph Options (continued)

To do this... use this menu option... ...or click this icon

Move a pane e Select the graph. Click Window > Move Pane. o=

¢ Select the pane or window and then drag it to the new
position. This position can be inside the same window
or within another window.

A four-headed arrow is shown when the cursor is on the
boundary of the active window or pane.

e |f the pane is at the top or bottom of the target pane,
then the pane moves above or below that pane,
respectively.

e Ifthe pane s at the left or right of the target pane, then
the pane moves to the left or right of that pane,
respectively.

e |f the pane is at any other position, then the pane
moves to the target row. The drop shadow of the pane
as the pane is moved indicates its new position.

Link panes a. With the two graphs open, click one to make that pane =
active.

b. Click Explore > Link and then click the other pane.

Remove linking Close one of the panes. Click Explore > Remove Link. x
Delete a pane Select the graph. Click Window > Delete Pane. >
Lock a pane Select the graph. Click Window > Lock Panes.
Hide a pane Select the graph. Click Window > Hide Pane. =
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Table 9-8 Graph Options (continued)

To do this... use this menu option... ...or click this icon
Maximize a pane Select the graph. Click Window > Maximize Pane. m
Tile panes Select the graph. Click Window > Tile all Panes. e

Zoom In on the Y-axis

1. Move the pointer to the left of the Y-axis to either side of the area to be expanded and then drag away from
the starting point in a vertical direction while holding the left mouse button.

A box is drawn along the y-axis representing the new scale.

Note: Take care when zooming in on the baseline. Zoom in too far and the zoom-in box closes.

2. Release the mouse button to draw the graph to the new scale.

Zoom In on the X-axis

Tip! To return the graph to the original scale, double-click either axis. To restore the entire graph to the original
scale, click Explore > Home Graph.

1. Move the pointer under the X-axis to either side of the area to be expanded and then drag away from the
starting point in a horizontal direction while holding the left mouse button.

2. Release the mouse button to draw the graph to the new scale.
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Regularly clean and maintain the system for optimal performance.

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the
/ T \ covers might cause injury or malfunctioning of the system. The covers need
not be removed for routine maintenance, inspection, or adjustment. Contact
a SCIEX Field Service Employee (FSE) for repairs that require the covers to be

removed.
A A‘ WARNING! lonizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
fa Determine whether decontamination is required prior to cleaning or
maintenance. The customer must decontaminate the system prior to cleaning
@ or maintenance if radioactive materials, biological agents, or toxic chemicals

have been used with the system.

Recommended Maintenance Schedule

Table 10-1 provides a recommended schedule for cleaning and maintaining the system.

Tip! Perform maintenance tasks regularly to make sure that the mass spectrometer is performing optimally.

For information on maintaining the ion source, refer to the ion source Operator Guide.

Contact a Qualified Maintenance Person (QMP) to order consumable parts. Contact a SCIEX Field Service Employee
(FSE) for maintenance service and support.

Table 10-1 Maintenance Tasks

Component Frequency Task For more information...
System
Tubing Daily Inspect the tubing | Refer to Chemical Precautions on page

and fittings to make | 10.
sure that they are
securely connected,
and that there are
no leaks.
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Table 10-1 Maintenance Tasks (continued)

Component Frequency Task For more information...

Mass Spectrometer

Curtain plate Daily Clean Refer to Clean the Curtain Plate on
page 99.

Orifice plate (front) [ Daily Clean Refer to Clean the Front of the Orifice

Plate on page 101.

Roughing pump oil [ Weekly

Inspect the level

Refer to Inspect the Roughing Pump Oil
Level on page 103.

Roughing pump oil | Every 6 to 12 months Replace Contact the local QMP or FSE.
Instrument As needed Clean Refer to Clean the Surfaces on page
surfaces 95.

Source exhaust | As needed Empty Refer to Empty the Source Exhaust
drain bottle Drain Bottle on page 101.

Orifice plate (front | As needed Clean Contact the local QMP or FSE.

and rear)

Qlet” ion guide  [As needed Clean Contact the local QMP or FSE.

and 1Q0 lens

QO rod setand 1Q1 | As needed Clean Contact the local QMP or FSE.

lens

Roughing pump oil [ As needed Refill Contact the local QMP or FSE.
Mass spectrometer | As needed Replace Replace the Mass Spectrometer Cooling
cooling fan filter Fans Filter on page 104.

Interface heater | As needed Replace Contact the local QMP or FSE.

lon Source

TurboIonSpray® As needed Inspect and replace |Refer to the ion source Operator
and APCI Guide.

electrodes

Corona discharge |As needed Replace Refer to the ion source Operator
needle Guide.

Turbo heater As needed Replace Contact the local QMP or FSE.
Sample tubing As needed Replace Refer to the ion source Operator

Guide.
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For “As needed” tasks, follow these guidelines:
¢ (Clean the mass spectrometer surfaces after a spill or when they become dirty.
e Empty the drain bottle before it becomes full.

e Clean the orifice plate, QJet” ion guide, and QO region if system sensitivity degrades.

Tip! Clean the QO region regularly to minimize the impact of charging (a significant loss of sensitivity of the
ions of interest over a short period of time) on the quadrupoles and lenses. Contact a QMP or FSE.

e Clean the QJet” ion guide and QO region if system sensitivity degrades.

Tip! Clean the QO region regularly to minimize the impact of charging (a significant loss of sensitivity of the
ions of interest over a short period of time) on the quadrupoles and lenses. Contact a QMP or FSE.

o Refill the roughing pump oil when it falls below the minimum oil level.

Clean the Surfaces

Clean the external surfaces of the mass spectrometer after a spill or when they become dirty.

CAUTION: Potential System Damage. Use only the recommended cleaning methods and
materials to avoid damaging the equipment.

1. Wipe the external surfaces with a soft cloth dampened with warm, soapy water.

2. Wipe the external surfaces with a soft cloth moistened with water to remove any soap residue.

Clean the Front-End

The following warning applies to all of the procedures in this section:

WARNING! Hot Surface Hazard. Let the ion source cool for at least 30 minutes
before starting any maintenance procedures. Surfaces of the ion source and
the vacuum interface components become hot during operation.

Clean the mass spectrometer front-end using the routine cleaning method, to:
e Minimize unscheduled system downtime.
e Maintain optimum sensitivity.

e Avoid more extensive cleaning that requires a service visit.
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When contamination occurs, perform an initial routine cleaning. Clean up to and including the front of the orifice
plate. If routine cleaning does not resolve issues with sensitivity, then a full cleaning might be necessary. Contact
the local QMP or FSE.

This section provides instructions for performing routine cleaning without breaking vacuum.

Note: Follow all of the applicable local regulations. For health and safety guidelines, refer to Chemical Precautions
on page 10.

Symptoms of Contamination

The system might be contaminated if any one of the following is observed:

¢ Significant loss in sensitivity

¢ Increased background noise

e Additional peaks that are not part of the sample are shown in full scan or survey scan methods

If any of these issues are observed, then clean the mass spectrometer front-end.

Required Materials

Note: U.S. customers can call 877-740-2129 for ordering information and inquiries. International customers
can visit sciex.com/contact-us.

¢ Powder-free gloves (nitrile or neoprene recommended)
o Safety glasses
e Laboratory coat

¢ Fresh, high-quality (pure) water (at least 18 MQ de-ionized [DI] water or ultra-pure HPLC-grade water). Old
water can contain contaminants that can further contaminate the mass spectrometer.

e MS-grade methanol, isopropanol (2-propanol), or acetonitrile
¢ (leaning solution. Use one of:
e 100% methanol
e 100% isopropanol
¢ 1:1 acetonitrile:water solution (freshly prepared)
e 1:1 acetonitrile:water with 0.1% acetic acid solution (freshly prepared)
e C(Clean 1 L or 500 mL glass beaker to prepare cleaning solutions
e 1 Lbeaker to catch used solvent

¢ Organic waste container
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¢ Lint-free wipes. Refer to Tools and Supplies Available from the Manufacturer on page 97.

e (Optional) Polyester (poly) swabs

Tools and Supplies Available from the Manufacturer

Description Part Number
Small poly swab (thermally bonded). Also available in the Cleaning kit. 1017396
Lint-free wipe (11 cm x 21 cm, 4.3 inches x 8.3 inches). Also available in the Cleaning 018027

kit.

Cleaging kit. Contains the small poly swab, lint-free wipes, QO cleaning tool, tapered 5020763
QJet ion guide cleaning brush, and Alconox packets.

Cleaning Best Practices

WARNING! Hot Surface Hazard. Let the ion source cool for at least 30 minutes
before starting any maintenance procedures. Surfaces of the ion source and
the vacuum interface components become hot during operation.

WARNING! Toxic Chemical Hazard. Refer to the chemical product Safety Data Sheets
and follow all of the recommended safety procedures when handling, storing, and
disposing of chemicals. For health and safety precautions, refer to the System User
Guide.

A A‘ WARNING! lonizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
6o Determine whether decontamination is required prior to cleaning or
; maintenance. The customer must decontaminate the system prior to cleaning

or maintenance if radioactive materials, biological agents, or toxic chemicals
have been used with the system.

E: WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.

¢ Allow the ion source to cool before removing it.
e Always wear clean, powder-free gloves (nitrile or neoprene recommended) for the cleaning procedures.

o After cleaning the mass spectrometer components, and before reassembling them, put on a new, clean pair
of gloves.
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¢ Do not use cleaning supplies other than those specified in this procedure.
¢ If possible, prepare cleaning solutions just before cleaning.

e Prepare and store all of the organic solutions and organic-containing solutions in very clean glassware only.
Never use plastic bottles. Contaminants can leach from these bottles and further contaminate the mass
spectrometer.

¢ To avoid contaminating the cleaning solution, pour the solution on the wipe or swab.

¢ Allow only the center area of the wipe to contact the mass spectrometer surface. Cut edges can leave fibers
behind.

Tip! Wrap the wipe around a thermally-bonded poly swab.

Figure 10-1 Example: Folding the Wipe

r

¢ To avoid cross-contamination, discard the wipe or swab after it has touched the surface once.

e Larger parts of the vacuum interface, such as the curtain plate, might require several cleanings, using multiple
wipes.

e Only dampen the wipe or swab slightly when applying water or cleaning solution. Water, more often than
organic solvents, might cause the wipe to deteriorate, leaving residue on the mass spectrometer.

e Do not rub the wipe across the aperture. Wipe around the aperture to prevent fibers from the wipes from
entering the mass spectrometer.

e Do not insert the brush in the aperture on the curtain plate or orifice plate.

Prepare the Mass Spectrometer

Note: Mass spectrometers with a NanoSpray® ion source might require a full cleaning for best results. Contact
a local QMP or an FSE.

WARNING! Hot Surface Hazard. Let the ion source cool for at least 30 minutes
before starting any maintenance procedures. Surfaces of the ion source and
the vacuum interface components become hot during operation.

TripleTOF® 5600/5600+ System System User Guide
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Service and Maintenance Information

CAUTION: Potential System Damage. Do not drop anything into the source drain when the
ion source is removed.

Figure 10-2 Source Drain on the Vacuum Interface

1. Deactivate the hardware profile.

2. Remove the ion source. Refer to the ion source Operator Guide.

When the ion source is not in use, store it to protect it from damage and to maintain operating integrity.

Clean the Curtain Plate

CAUTION: Potential System Damage. Do not rest the curtain plate or orifice plate on the
aperture tip. Make sure that the conical side of the curtain plate faces up.

CAUTION: Potential System Damage. Do not insert a wire or metal brush into the aperture
on the curtain plate, orifice plate, or interface heater to avoid damaging the aperture.

1. Pull the curtain plate off of the vacuum interface and then put it, conical side up, on a clean, stable surface.
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Service and Maintenance Information

Figure 10-3 Curtain Plate Removal

The curtain plate is held in place by three retaining ball catches mounted on the orifice plate.

Tip! If the curtain plate does not immediately separate from the orifice plate, then turn the curtain plate
slightly (less than 90 degrees) to release the ball spring latches.

2. Dampen a lint-free wipe with pure water and then clean both sides of the curtain plate.

Note: Use multiple wipes, as required.

Repeat step 2 using the cleaning solution.
Using a dampened wipe or small poly swab, clean the aperture.

Wait until the curtain plate is dry.

AN A T

Inspect the curtain plate for solvent stains or lint, removing any residue with a clean, slightly damp, lint-free
wipe.

Note: Persistent spotting or filming is an indicator of contaminated solvent.
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Service and Maintenance Information

Clean the Front of the Orifice Plate

CAUTION: Potential System Damage. When cleaning the surface of the orifice plate, do
not remove the interface heater. Frequent removal of the interface heater can result in
damage to the interface heater. Surface cleaning of the interface heater is adequate for
routine cleaning.

CAUTION: Potential System Damage. Do not insert a wire or metal brush into the aperture
on the curtain plate, orifice plate, or interface heater to avoid damaging the aperture.

1. Dampen a lint-free wipe with water and then wipe the front of the orifice plate, including the interface heater.
Repeat step 1 using the cleaning solution.

Wait until the orifice plate is dry.

El

Inspect the orifice plate for solvent stains or lint, removing any residue with a clean, slightly damp, lint-free
wipe.

Note: Persistent spotting or filming is an indicator of contaminated solvent.

Put the Mass Spectrometer Back in Service

1. Install the curtain plate on the mass spectrometer.

2. Install the ion source on the mass spectrometer. Refer to the ion source Operator Guide.

Tighten the ion source by turning the source latches down into the locking position.

3. Activate the hardware profile.

Empty the Source Exhaust Drain Bottle

A WARNING! lonizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.

Deposit hazardous materials in appropriately labeled waste containers and
@ dispose of them according to local regulations.
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Service and Maintenance Information

A A WARNING! lonizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
2 Take care to vent exhaust gases to a dedicated laboratory fume hood or
exhaust system and make sure that the ventilation tubing is secured with
@ clamps. Make sure that the laboratory has appropriate air exchange for the
work performed.

Inspect the source exhaust drain bottle regularly, and empty it before it becomes full. Also inspect the bottle and
its fitting for leaks, and tighten connections or replace components, if required. Follow the steps in this procedure
to empty the bottle.

1. Remove the ion source. Refer to the ion source Operator Guide.

2. Loosen the clamps connecting the hoses to the cap of the source exhaust drain bottle.

Figure 10-4 Source Exhaust Drain Bottle

GFWH
— %
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Service and Maintenance Information

Item Description
1 Connection to vent
2 Source exhaust drain tubing: 2.5 cm (1.0 inch) inside diameter (i.d.)
3 Roughing pump exhaust hose: 3.2 cm (1.25 inch) i.d.
4 Source exhaust drain bottle. In this drawing, the capped drain bottle is shown at the

back of the mass spectrometer to make connection points visible. The drain bottle might
be located at the side of the mass spectrometer in the drain bottle holder. Make sure
that the bottle is secured to prevent spillage.

5 Connection to the mass spectrometer: 1.6 cm (0.625 inch) i.d.

6 Roughing pump vacuum inlet hose

Note: Source exhaust hose connections at the drain bottle, mass spectrometer, and the lab vent are secured
with hose clamps.

Disconnect the hoses from the cap.
If applicable, lift the drain bottle out of the holder.

Remove the cap from the drain bottle.

AN A

Empty the drain bottle and then dispose of the waste according to laboratory procedures and local waste
regulations.

~

Install the cap on the bottle and then put the bottle in the holder.
8. Attach the hoses to the cap and then secure them tightly with clamps.

Inspect the Roughing Pump Oil Level

¢ Inspect the sight glass on the roughing pump to verify that the oil is above the minimum level.

If the oil is below the minimum level, then contact the qualified maintenance person (QMP) or SCIEX field
service employee (FSE).
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Service and Maintenance Information

Figure 10-5 Sight Glass

Replace the Mass Spectrometer Cooling Fans Filter

The mass spectrometer cooling fans are on the left side of the mass spectrometer.

Prerequisite Procedures

e Shut down the system by following the procedure in the System User Guide.

WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.
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104 / 131 RUO-IDV-05-7040-B



Service and Maintenance Information

1. Remove the four thumbscrews on the cooling fan cover.

Figure 10-6 Cooling Fan Filters

2. Remove the filter and then replace it with a new one.

Figure 10-7 Cooling Fans Filter

Item Description
1 Cooling fans cover
2 Filter

3. Install the filter cover.
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Service and Maintenance Information

Storage and Handling

Ej WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.

If the mass spectrometer must be stored for a long time or prepared for shipping, then contact a SCIEX FSE for
decommissioning information. To disconnect power from the mass spectrometer, remove the mains supply connector
from the AC mains supply.

Note: The ion source and mass spectrometer must be transported and stored between —30 °C to +60 °C (-22
°F to 140 °F). Store the system at an altitude not exceeding 2 000 m (6 562 feet) above sea level.
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106 / 131 RUO-IDV-05-7040-B



Mass Spectrometer
Troubleshooting

11

This section contains information for troubleshooting basic system issues. Certain activities can only be carried
out by a SCIEX -trained Qualified Maintenance Person (QMP) in the laboratory. For advanced troubleshooting,
contact a SCIEX Field Service Employee (FSE).

Table 11-1 System Issues

Symptom

Possible Cause

Corrective Action

The QJet” ion guide is extremely dirty
or frequently becomes dirty.

The Curtain Gas™ flow rate is too
low.

Verify the setting for the CUR
parameter, and increase it, if
applicable.

A system fault has occurred because
the vacuum pressure is too high.

—_

. The roughing pump oil level is
too low.

2. There is a leak.

3. The wrong orifice plate is
installed.

1. Inspect the roughing pump oil
level, and then contact the local
QMP or an FSE to add oil.

2. Inspect and repair leaks.

3. Install the correct orifice plate.

A system fault has occurred because
the QPS exciter module temperature
is too high.

—_

. Ambient temperature is too high.

Contact the local QMP or FSE.

The Analyst® TF software reports that
the mass spectrometer is in Fault
status because of the ion source.

—_

. The probe is not installed.

2. The probe is not connected
securely.

1. Confirm the fault in the Status
panel of the device details page.

2. Install the probe. Refer to the ion
source Operator Guide.

3. Remove and replace the probe.
Tighten the retaining ring
securely. Refer to the ion source
Operator Guide.

The Analyst” TF software indicates
that the APCI p@robe is in use, but the
TurbolonSpray  probe is installed.

The F3 fuse is blown.

Contact an FSE.

The spray is not uniform.

The electrode is blocked.

Clean or replace the electrode. Refer
to the ion source Operator Guide.
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Mass Spectrometer Troubleshooting

Table 11-1 System Issues (continued)

Symptom

Possible Cause

Corrective Action

Sensitivity is reduced.

1.

The ion source parameters are
not optimized.

1.

Optimize the ion source
parameters. Refer to
theAnalyst TF software Help

system or connections.

2. The mass spectrometer is not
- system.
optimized.
3. The curtain plate is dirty. 2. Refer to Clean the Curtain Plate
on page 99.
4 The or|f|c®e plate s dirty. 3. Refer to Clean the Front of the
5. The Qlet ion guide or 1Q0 lens Orifice Plate on page 101 or
is dirty. contact the local QMP or FSE.
6. The QO region is dirty. 4. Clean the QO region. Contact the
7. The syringe or sample line is QMP or FSE.
leaking. 5. Inspect the syringe or sample line
8. The sample has degraded or has | for 1eaks, and repair any leaks
a low concentration. found. Make sure that all flttlngs
are the correct type and size.
9. The probe is not installed ) )
6. Verify the sample concentration.
properly.
Use a fresh sample.
7. Remove and install the probe.
Sensitivity is reduced. 1. Theion source is not installed 1. Remove and install the ion
(continued) properly, or it is faulty. source, making sure that the
2. One or more of the O-rings on the Ia’Fches are properly secur.ed. I
. L this does not resolve the issue,
vacuum interface is missing. : .
then install and optimize an
3. There is an issue with the LC alternate ion source.

. Troubleshoot the LC system.

If the O-rings are on the ion
source, then install them on the
vacuum interface. If they are
missing, then contact an FSE.
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Mass Spectrometer Troubleshooting

Table 11-1 System Issues (continued)

Symptom

Possible Cause

Corrective Action

The mass spectrometer performance
has degraded.

—_

. The probe is not optimized.

2. The sample was not prepared
correctly or the sample has
degraded.

3. The sample inlet fittings are
leaking.

1. Optimize the probe. Refer to the
ion source Operator Guide.

2. Confirm that the sample was
prepared correctly.

3. Verify that the fittings are the
right size and type and make sure
that they are tight. Do not
overtighten the fittings. Replace
the fittings if leaks continue.

4. Install and optimize an alternate
ion source.

5. Contact an FSE if the issue
persists.

Arcing or sparks occur.

The position of the corona discharge
needle is incorrect.

Turn the corona discharge needle

toward the curtain plate, and away
from the stream of heater gas. Refer
to the ion source Operator Guide.

For sales, technical assistance, or service, contact an FSE or visit the SCIEX Web site at sciex.com for contact

information.
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Recommended Calibration lons

A

The following tables list the standards recommended by SCIEX for calibrating the TripleTOF® 5600* system. For
information about tuning solutions, refer to Tune and Calibrate on page 47.

Table A-1 Q1 PPG Positive Calibration lons

Masses
59.04914 233.17472 442.33740 674.50484 906.67228 1196.88158
Table A-2 Q1 PPG Negative Calibration lons
Masses
4499819 411.25991 585.38549 933.63665 1165.80409

Table A-3 APCI Positive Calibration Solution and ESI Positive Calibration Solution: TOF MS

TOF MS Masses
aminoheptanoic acid 146.11756
amino-dPEG 4-acid 266.15981
clomipramine 315.16225
amino-dPEG 6-acid 354.21224
amino-dPEG 8-acid 442.26467
reserpine 609.28066
amino-dPEG 12-acid 618.36953
Hexakis(2,2,3,3-tetrafluoropropoxy) phosphazene 922.0098
Hexakis(1H, 1H,5H-octafluoropentoxy)phosphazene 1521.97148
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Recommended Calibration lons

Table A-4 APCI Positive Calibration Solution and ESI Positive Calibration Solution: MSMS

(Clomipramine)

MSMS (Clomipramine) Masses
C3HgN 58.0651
CsHy,N 86.0964
CigHqaN 220.1121
Cy4H;oNCl 227.0496
Ci7HyoN 235.1356
CysHqsNCl 242.0731
Cy7Hq7CIN 270.1044
Ci9H53CIN, 315.16225

Table A-5 APCI Negative Calibration Solution and ESI Negative Calibration Solution: TOF MS

TOF MS Masses

7-aminoheptanoic acid 144.103

amino-dPEG 4-acid 264.14526
sulfinpyrazone fragment 277.09825
amino-dPEG 6-acid 352.19769
sulfinpyrazone 403.11219
amino-dPEG 8-acid 440.25012
amino-dPEG 12-acid 616.35498
amino-dPEG 16-acid 792.45984

Table A-6 APCI Negative Calibration Solution and ESI Negative Calibration Solution: MSMS

(Sulfinpyrazone)

MSMS (Sulfinpyrazone) Masses
CeHsO 93.0344
CeHs0S 125.0067
C1oHgNO 158.06114
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Recommended Calibration lons

Table A-6 APCI Negative Calibration Solution and ESI Negative Calibration Solution: MSMS

(Sulfinpyrazone) (continued)

MSMS (Sulfinpyrazone) Masses
Ci7H13N,0, 277.0983
C,3H,0N, 055 403.11219

Table A-7 APCI Negative Calibration Solution and ESI Negative Calibration Solution: MSMS

(Sulfinpyrazone Fragment)

MSMS (Sulfinpyrazone Fragment) Masses
CgHs 77.03967
CgHgN 116.0506
CoHgN 130.0662
C1oHgNO 158.0611
C11HgN,0, 200.0591
CisHoN, 217.0771
Cy6H13N,0 249.1033
Cy7Hq3N,0, 277.09825

TripleTOF® 5600/5600+ System
112 /7131

System User Guide
RUO-IDV-05-7040-B



Exact Masses and Chemical
Formulas B

PPG

Table B-1 contains the exact monoisotopic masses and charged species (positive and negative) observed with the
PPG (polypropylene glycol) calibration solutions. The masses and ions were calculated using the formula M =
H[OC5Hgl,,OH, while the positive ion MSMS fragments used the formula, [OC3H6]n(H+). In all calculations, H =
1.007825, O = 15.99491, C = 12.00000, and N = 14.00307.

Note: When performing calibrations with the PPG solutions, use the correct isotope peak.

Table B-1 PPG Exact Masses

n Exact Mass (M) (M + NH,)* MSMS (M + NH»)** | (M + COOH)
Fragments
1 76.05242 94.08624 59.04914 56.06003  |121.05061
2 134.09428 152.12810 117.09100 85.08096  |179.09247
3 192.13614 210.16996 175.13286 114.10189  |237.13433
4 250.17800 268.21182 233.17472 143.12282  |295.17619
5 308.21986 326.25368 291.21658 172.14375  |353.21805
6 366.26172 384.29554 349.25844 201.16468  [411.25991
7 424.30358 442.33740 407.30030 230.18561  |469.30177
8 482.34544 500.37926 465.34216 259.20654  |527.34363
9 540.38730 558.42112 523.38402 288.22747  [585.38549
10 598.42916 616.46298 581.42588 317.24840  |643.42735
11 656.47102 674.50484 639.46774 346.26933  [701.46921
12 714.51288 732.54670 697.50960 375.29026  |759.51107
13 772.55474 790.58856 755.55146 40431119 [817.55293
14 830.59660 848.63042 813.59332 43333212 [875.59479
15 888.63846 906.67228 871.63518 46235305  [933.63665
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Exact Masses and Chemical Formulas

Table B-1 PPG Exact Masses (continued)

n Exact Mass (M) (M + NH,)* MSMS (M + NH»)** | (M + COOH)
Fragments
16 946.68032 964.71414 929.67704 491.37398  |991.67851
17 1004.72218 1022.75600 987.71890 520.39491 1049.72037
18 1062.76404 1080.79786 1045.76076 549.41584  [1107.76223
19 1120.80590 1138.83972 1103.80262 578.43677  [1165.80409
20 1178.84776 1196.88158 1161.84448 607.45770  [1223.84595
21 1236.88962 1254.92344 1219.88634 636.47863  |1281.88781
22 1294.93148 1312.96530 1277.92820 665.49956  [1339.92967
Reserpine
Table B-2 Reserpine Exact Masses
Reserpine (C33H4oN;00)
Description Mass
Molecular lon C33H41N,0q 609.28066
Fragment Cy3H3)NOg 448.19659
Fragment C,5H,9N,0, 397.21218
Fragment Cy,H,5N,05 365.18597
Fragment C;3H,gNO; 236.12812
Fragment C;oH,0,4 195.06519
Fragment C;,H,,NO 174.09134
Taurocholic Acid
Table B-3 Taurocholic Acid Exact Masses
Taurocholic Acid (C,5H45N05S)
Description Mass
Molecular lon C,6H44NO5S 514.28440
Fragment C,H505S 106.98084
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Exact Masses and Chemical Formulas

Table B-3 Taurocholic Acid Exact Masses (continued)

Description Mass
Fragment C,H¢gNO3S 124.00739
Fragment SO5 79.95736

TOF Calibration Solution

Table B-4 TOF Calibration Solution Exact Masses

Description Mass

Molecular lon Cs* 132.90488

Molecular lon Peptide ALILTLVS 829.53933
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Toolbar Icons C

For additional toolbar icons, refer to the Advanced User Guide.

Table C-1 Tool Bar Icons

Icon Name Description
New Subproject | Creates a subproject. Subprojects can only be created later in the process
3 . : > , :
if the project was originally created with subprojects.
Copy Subproject | Copies a Subproject folder.
py >ubproj Y proj

Subprojects can be copied only from another project that has existing
subprojects. If the same folders exist at both the project and subproject levels,
then the software uses the project level folders.

Table C-2 Acquisition Method Editor Icons

Icon Name Description
& Mass Spec Click to show the MS tab in the Acquisition Method editor.
& Period Right-click to add an experiment, add an IDA Criteria Level, or delete the
period.
th Autosampler Click to open the Autosampler Properties tab.
Syringe Pump Click to open the Syringe Pump Properties tab.
(@ Column Oven Click to open the Column Oven Properties tab.
& Valve Click to open the Valve Properties tab.
4 DAD Click to open the DAD Method Editor. Refer to DAD Data on page 86.
ﬁT ADC Click to open the ADC Properties tab. Refer to Show ADC Data on page 78.
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Toolbar Icons

Table C-3 Acquire Mode Icons

Icon Name Description
o View Queue Shows the sample queue.
- Instrument Queue | Shows a remote instrument station.

Status for Remote

Shows the status of a remote instrument.

Instrument
K Start Sample Starts the sample in the queue.
B Stop Sample Stops the sample in the queue.
& Abort Sample Aborts a sample acquisition in the middle of the processing of that sample.
@ Stop Queue Stops the queue before it has completed processing all the samples.
I Pause Sample Inserts a pause in the queue.
Now
i, Insert Pause Inserts a pause before a specific sample.
before Selected
Sample(s)
i, Continue Sample | Continues acquiring the sample.
% Next Period Starts a new period.
I Extend Period Extends the current period.
ity Next Sample Stops acquiring the current sample and starts acquiring the next sample.
. Equilibrate Selects the method to be used to equilibrate the devices. This method should
be the same as the method used with the first sample in the queue.
b Standby Puts the instrument in Standby mode.
o Ready Puts the instrument in Ready mode.
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Toolbar Icons

Table C-3 Acquire Mode Icons (continued)

Icon Name Description
T Reserve Reserves the mass spectrometer for tuning and calibrating.
Instrument for
Tuning
$ Method Wizard | Starts the Method Wizard.
E Purge Modifier | Starts the modifier purge from the modifier pump.

Table C-4 Tune and Calibrate Mode Icons

Icon Name Description
A Calibrate from Opens the Mass Calibration Option dialog and uses the active spectrum to
o spectrum calibrate the mass spectrometer.
r“ Manual Tune Opens the Manual Tune Editor.
II=
A Instrument Verifies the instrument performance, adjusts the mass calibration, or adjusts
Optimization mass spectrometer settings.
g View Queue Views the sample queue.
- Instrument Queue | Views a remote instrument.
Status for Remote [ Views the status of a remote instrument.
Instrument
T Reserve Reserves the instrument for tuning and calibrating.
Instrument for
Tuning
- Purge Modifier [ Click to purge or clear modifier from the modifier pump.
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Table C-5 Explore Quick Reference: Chromatograms and Spectrum

Icon

Name

Description

Open Data File

Opens files.

Show Next Sample

Goes to the next sample.

(]| B [w

Show Previous
Sample

Goes to the previous sample.

Go To Sample Opens the Select Sample dialog.
List Data Views the data in tables.
Show TIC Generates a TIC from a spectrum.

ﬁ

Extract Using
Dialog

Extracts ions by selecting masses.

El

Show Base Peak
Chromatogram

Generates a BPC.

Show Spectrum

Generates a spectrum from a TIC.

@] [E]

Copy Graph to
new Window

Copies the active graph to a new window.

Baseline Subtract

Opens the Baseline Subtract dialog.

ENE

Threshold Adjusts the threshold.
m Noise Filter Shows the Noise Filter Options dialog, which can be used define the minimum
width of a peak. Signals below this minimum width are regarded as noise.
T Show ADC Shows ADC data.
Show File Info Shows the experimental conditions used to collect the data.
Add arrows Adds arrows to the X-axis of the active graph.

Remove all arrows

Removes arrows from the X-axis of the active graph.

siENEE

Offset Graph

Compensates for slight differences in the time during which the ADC data and
the mass spectrometer data were recorded. This is useful when overlaying

graphs for comparison.
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Table C-5 Explore Quick Reference: Chromatograms and Spectrum (continued)

Icon Name Description
sbe Force Peak Labels | Labels all of the peaks.
L Expand Selection |Sets the expansion factor for a portion of a graph to be viewed in greater

By

detail.

Clear ranges

Returns the expanded selection to normal view.

[=]| X

Set Selection

Defines start and stop points for a selection. This feature provides more accurate
selection than is possible by selecting the region using the cursor.

Normalize To Max

Scales a graph to maximum size, so that the most intense peak is scaled to
full scale, whether or not it is visible.

@]

Show History

Shows a summary of data processing operations performed on a particular
file, such as smoothing, subtraction, calibration, and noise filtering.

Open Compound | Opens the compound database.
Database
Set Threshold Adjusts the threshold.
W Show Contour Plot | Shows selected data as either a spectrum graph or an XIC. Additionally, for
data acquired by a DAD, a contour plot can show selected data as either a
DAD spectrum or an XWC.
Show DAD TWC | Generates a TWC of the DAD spectrum.
e Show DAD Generates a DAD spectrum.
Spectrum
Extract Extracts up to three wavelength ranges from a DAD spectrum to view the XWC.
Wavelength

Table C-6 Explore Toolbar Quick Reference: Overlaying Graphs

Icon Name Description
Home Graph Click to return the graph to the original scale.
Overlay Click to overlay graphs.
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Table C-6 Explore Toolbar Quick Reference: Overlaying Graphs (continued)

Icon Name Description
Cycle Overlays Click to cycle between overlaid graphs.

Sum Overlays

Click to add the graphs together.

Table C-7 Explore Toolbar Quick Reference: Fragment Interpretation Tool

Icon

Name

Description

o

Show Fragment
Interpretation Tool

Click to open Fragment Interpretation tool, which calculates the single,
non-cyclic bond cleavage fragments from a .mol file.

Table C-8 Navigation Icons on the Explore Toolbar

Icon Name Function
Open File Click to open files.
Show Next Sample | Click to navigate to the next sample.

(]| B3] [w]

Show Previous
Sample

Click to navigate to the previous sample.

GoTo Sample Click to open the Select Sample dialog.
List Data Click to view the data in tables.

Show TIC Click to generate a TIC from a spectrum.
FE

Extract Using
Dialog

Click to extract ions by selecting masses.

Bl

Show Base Peak
Chromatogram

Click to generate a BPC.

Show Spectrum

Click to generate a spectrum from a TIC.

@] [E]

Copy Graph to
new Window

Click to copy the active graph to a new window.

El

Baseline Subtract

Click to open the Baseline Subtract dialog.
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Table C-8 Navigation Icons on the Explore Toolbar (continued)

Icon Name Function
Threshold Click to adjust the threshold.
L Noise Filter Click to use the Noise Filter Options dialog to define the minimum width of a
peak. Signals below this minimum width are regarded as noise.
e Show ADC Click to view ADC data.
Show File Info Click to show the experimental conditions you used to collect your data.
Add arrows Click to add arrows to the x-axis of the active graph.

X| [#]| E

i
&'

Remove all arrows

Click to remove arrows from the x-axis of the active graph.

El

Offset Graph

Click to compensate for slight differences in the time during which the ADC
data and the mass spectrometer data were recorded. This is useful when
overlaying graphs for comparison.

a
=2
H

Force Peak Labels

Click to label all the peaks.

|

Expand Selection
By

Click to set the expansion factor for a portion of a graph that you want to view
in greater detail.

Clear ranges

Click to return the expanded selection to normal view.

= | [

Set Selection

Click to type start and stop points for a selection. This provides more accurate
selection than is possible by highlighting the region using the cursor.

Normalize to Max

Click to scale a graph to maximum, so that the most intense peak is scaled is
to full scale, whether or not it is visible.

@]

Show History

Click to view a summary of data processing operations performed on a
particular file, such as smoothing, subtraction, calibration, and noise filtering.

Open Compound | Click to open the compound database.
Database
Set Threshold Click to adjust the threshold.
W Show Contour Plot | Click to display selected data as either a spectrum graph or an XIC. Additionally,
for data acquired by a DAD, a contour plot can display selected data as either
a DAD spectrum or an XWC.
Show DAD TWC | Click to generate a TWC of the DAD.
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Toolbar Icons

Table C-8 Navigation Icons on the Explore Toolbar (continued)

Icon Name Function
Sl Show DAD Click to generate a DAD spectrum.
Spectrum
Extract Click to extract up to three wavelength ranges from a DAD spectrum to view
Wavelength the XWC.

Table C-9 Integration Tab and Quantitation Wizard Icons

Icon

Name

Description

A

Set parameters from
Background Region

Uses the selected peak.

Select Peak

Uses the selected background.

Manual Integration Mode

Manually integrates peaks.

Show or Hide Parameters

Toggles the peak-finding parameters between shown and hidden.

Show Active Graph

Shows the analyte chromatogram only.

Show Both Analyte and IS

Shows the analyte and its associated chromatogram (available only
when an associated internal standard exists).

=l B E| = & =

Use Default View for Graph

Returns to the preset (view all data) view (if, for example, the user
has zoomed in on a chromatogram).

Table C-10 Results Table Icons

Icon Name Description
& Sort Ascending by Selection | Sorts the selected column by ascending values.
= Sort Descending by Sorts the selected column by descending values.
= selection
Lock Or Unlock Column  [Locks or unlocks the selected column. A locked column cannot be
moved.
= Metric Plot By Selection | Creates a metric plot from the selected column.
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Toolbar Icons

Table C-10 Results Table Icons (continued)

Icon Name Description
nal Show all Samples Shows all the samples in the Results Table.
= Delete Formula Column | Deletes formula columns.
Report Generator Opens the Reporter software.

Table C-11 Icon Quick Reference: Quantitate Mode

Report Generator

Icon Name Description
Add/Remove Samples Adds or removes samples from the Results Table.
& Export as Text Saves the Results Table as a text file.
= Modify Method Opens a wiff file.
Y Peak Review - Pane Opens peaks in a pane.
B Peak Review - Window Opens peaks in a window.
L/ Calibration - Pane Opens the calibration curve in a pane.
i Calibration - Window Opens the calibration curve in a window.
A Show First Peak Shows the first peak in the pane or window.
A Show Last Peak Shows the last peak in the pane or window.
B Show Audit Trail Shows the audit trail for the Results Table.
IEI Clear Audit Trail Clears the audit trail for the Results Table. This functionality is not
available.
Statistics Opens the Statistics window.
E

Opens the Reporter software.
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Glossary of Symbols D

Note: Not all of the symbols in the following table are applicable to every instrument.

Symbol Description
2 Australian Regulatory Compliance Mark. Indicates the products complies with Australian

communications Media Authority (ACMA) EMC Requirements.

Alternating current

A Amperes (current)

Authorized representative in the European community

B

Biohazard

CE Marking of Conformity

N

cCSAus mark. Indicates electrical safety certification for Canada and USA.

ﬂ’ﬁ‘
@

Catalogue number

Caution

> &

Note: In SCIEX documentation, this symbol identifies a personal injury hazard.
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Glossary of Symbols

Symbol

Description

®
®

China RoHS Caution Label. The electronic information product contains certain toxic or
hazardous substances. The center number is the Environmentally Friendly Use Period
(EFUP) date, and indicates the number of calendar years the product can be in operation.
Upon the expiration of the EFUP, the product must be immediately recycled. The circling
arrows indicate the product is recyclable. The date code on the label or product indicates
the date of manufacture.

China RoHS logo. The device does not contain toxic and hazardous substances or elements
above the maximum concentration values, and it is an environmentally-friendly product
that can be recycled and reused.

Consult instructions for use.

cTUVus mark for TUV Rheinland of North America.

Data Matrix symbol that can be scanned by a barcode reader to obtain a unique device
identifier (UDI).

Ethernet connection

Explosion Hazard

Fire Hazard

Flammable Chemical Hazard

Fragile
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Glossary of Symbols

Symbol

Description

Fuse

Hertz

High Voltage. Electrical Shock Hazard

If the main cover must be removed, contact a SCIEX representative to prevent electric

shock.

Hot Surface Hazard

In Vitro Diagnostic Device

lonizing Radiation Hazard

Keep dry.

Do not expose to rain.

Relative humidity must not exceed 99%.

Keep upright.

Laser Radiation Hazard

Lifting Hazard

Manufacturer

S A =4 N YR

Moving Parts Hazard
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Glossary of Symbols

Symbol Description
Pinch Hazard

Pressurized Gas Hazard

Protective Earth (ground)

Puncture Hazard

Puncture Hazard

Reactive Chemical Hazard

Serial number

Toxic Chemical Hazard

103 kPa[ Transport and store the system within 66 kPa to 103 kPa.

QB B B B e > B

66 kPa

o1kPa | Transport and store the system within 75 kPa to 101 kPa.

&,

75 kPa

Transport and store the system within 10% to 90% relative humidity.

e

10%

JH/MS Transport and store the system within =30 °C to +45 °C.
=30
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Glossary of Symbols

Symbol

Description

+80°C
-30°C

Transport and store the system within =30 °C to +60 °C.

USB 2.0 connection

USB 3.0 connection

Ultraviolet Radiation Hazard

Volt Ampere (power)

Volts (voltage)

WEEE. Do not dispose of equipment as unsorted municipal waste. Environmental Hazard

Watts

ri_lélii <§%‘%&‘

yyyy-mm-dd
Date of manufacture
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Glossary of Warnings

Note: If any of the labels used to identify a component become detached, contact an FSE.

Label Translation (if applicable)
FOR RESEARCH USE ONLY. NOT FOR USE IN FOR RESEARCH USE ONLY. NOT FOR USE IN
DIAGNOSTIC PROCEDURES. DIAGNOSTIC PROCEDURES.

IMPACT INDICATOR
SENSITIVE PRODUCT WARNING

IMPACT INDICATOR
SENSITIVE PRODUCT WARNING

Note: If the indicator is tripped, then this container
has been dropped or otherwise mishandled. Make a
note on the Bill of Lading and then check for damage.
Any claims for shock damage require a notation.

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE INCLUDING
TRIPPED “IMPACT INDICATOR" OR “TILT INDICATOR"
ON THE WAYBILL BEFORE ACCEPTING SHIPMENT AND
NOTIFY YOUR LOCAL AB SCIEX CUSTOMER SUPPORT
ENGINEER IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR LOCAL CUSTOMER
SUPPORT ENGINEER FOR UNCRATING AND
INSTALLATION.

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE INCLUDING
TRIPPED “IMPACT INDICATOR" OR “TILT INDICATOR"
ON THE WAYBILL BEFORE ACCEPTING SHIPMENT AND
NOTIFY YOUR LOCAL AB SCIEX CUSTOMER SUPPORT
ENGINEER IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR LOCAL CUSTOMER
SUPPORT ENGINEER FOR UNCRATING AND
INSTALLATION.

TIP & TELL

Tilt Indicator

Note: Indicates whether the container was tipped or
mishandled. Write on the Bill of Lading and inspect
for damage. Any claims for tipping require a notation.
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Glossary of Warnings

Label Translation (if applicable)
TiltWatch PLUS Tilt Indicator
ShockWatch

Note: Indicates whether the container was tipped or
mishandled. Write on the Bill of Lading and inspect
for damage. Any claims for tipping require a notation.

WARNING: DO NOT OPERATE WITHOUT FIRST WARNING: DO NOT OPERATE WITHOUT FIRST
ENSURING BOTTLE CAP IS SECURED. ENSURING BOTTLE CAP IS SECURED.

Note: This warning is attached to the source exhaust
waste bottle.

WARNING: NO USER SERVICEABLE PARTS INSIDE. WARNING: NO USER SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED PERSONNEL. REFER SERVICING TO QUALIFIED PERSONNEL.

Note: Consult instructions for use.
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